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Preface Business process management is the way to address business issues in today’s economic world. The velocity of change, driven by the dynamics of commerce and e-business, force you to have an IT system that is ready to be changed rapidly, and continually. Another issue is the integration of the Internet within business processes and more general multi-channel delivery. Companies must be able to provide a consistent service across all channels. To achieve this, you need to have an integrated business view. Business Process Management is the externalization and formalization of knowledge and expertise within applications and minds. That externalization makes it possible to stay in control of your business. In this redbook we introduce the concepts of business process management and its relationship with business-to-business technologies. In the second part of the book, we explore an example of a business process built in MQSeries Workflow. In the third part of the book we extend this intra-enterprise business process to include collaboration with external companies using WebSphere Business-to-Business Partner Agreement Manager. The final part of the book takes one step back and looks in more general terms at the patterns of developing and deploying business-to-business solutions. This redbook is the first in a series of three Redbooks about Business Process Management. This first book provides some technology background information about this area and demonstrates a scenario using the MQSeries Family and Partner Agreement Manager. The second redbook will build on that and extend the solution within the enterprise. The third redbook will extend the scenario by using more possibilities to extend the business process to external enterprises.
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Part 1. Technology overview In the first part of this book, we take a closer look at the concepts of Business Process Management (BPM) and Business-to-Business (B2B) applications. We describe what is characteristic for a BPM environment and what is behind the B2B message. Both terms appear often in the media but it is not always clear what is meant. We also explain some technologies and standards that are often used in B2B and BPM environments.
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Chapter 1. Introducing Business Process Management In this chapter we introduce the whats and whys behind Business Process Management. We will introduce some concepts to assist in modeling and implementing a business process.



1.1 What is Business Process Management? Business Process Management, as defined by the Gartner group, is the art of understanding, codifying, automating, and improving the way a company does business. For several years now, three-tier application development has been commonly used, or at least its importance has been recognized. In a three-tier environment, there is a separation between the presentation logic, the business logic, and the data access logic. This separation can be complete in the sense that every tier is running on a different machine. Consider the example of a browser-based application. The browser, driven by HTML, is responsible for the personalization layer. The business logic is encapsulated in an application server (servlet, Enterprise JavaBeans, etc.). The data that you access from the application server can be managed by a database server on a remote machine. Business Process Management is the next step in a three-tier environment. Business logic and business rules, now encapsulated in the business logic tier, is extracted from the business logic tier and is presented in a workflow-based environment, which shows graphically the different steps of a business process. At each node, business rules are used to select the next node and business logic is executed. The immediate consequence is that the application logic at each step is greatly simplified. It is executed only in specific cases. There is no logic needed to handle complex cases and to filter or categorize different business situations. This will be done at the workflow level, at the graphical user interface level that controls the business process, and not in the application logic. As a consequence, the business rules have become explicit, visible, and rapidly changeable. This allows a company to react more quickly on changes in the marketplace where it operates. Another way of looking at Business Process Management as a marriage between document workflow and enterprise application integration.
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Traditional workflow applications were people oriented. A person was presented with an electronic version of a document that he had to complete or approve or act upon. In an enterprise application integration environment, applications are linked to each other and they collaborate without human intervention. Typically, the applications use a messaging system to exchange information. Business Process Management is now the union of those two techniques. It is a combination of people-oriented workflow and application integration.



1.2 Why is it important? There are a number of reasons to focus on Business Process Management. First of all, it is clear that every enterprise is faced with rapid changes in its environment. These changes are not discovered by the IT department that runs the business applications, but rather by the company’s business analyst, who will recognize the need for change. That business analyst needs the tools to implement updated business rules without re-engineering the whole IT system. These Business Process Management tools separate the what from the how, the business processes and its metrics from the IT infrastructure. This results in process independence, where a business process instantiation steps through a number of reusable business services. Another aspect that drives us to Business Process Management is the addition of a new type of user of your internal applications. The popularity of the Internet has opened new ways for customers and business partners to interact with your company. Web-driven applications can greatly increase customer satisfaction. The next step is getting your business partners into your IT environment. They too expect a more flexible approach by using B2B integration and Internet market technologies. To cope with these new channels and to make sure that your company provides a consistent level of service across all channels, your existing IT infrastructure is just not flexible enough. It was designed for internal use only, not for your customers and business partners. Data connectivity and application integration is just not enough to tackle these challenges, because they lack the integration with the human component. And finally, in today’s world it is key that a business be in control of its objectives. Execution of business processes must reflect the business objectives. But before control there is understanding. You need an integrated business view of your enterprise, from the process through to the resources and assets that participate in them. Business Process Management leverages the knowledge embedded in your application and the minds of the people running your business. Formalizing the business process will help
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gain new insights into the operations of your company. The roles of different staff members and their relationships with suppliers and customers become more clear. Once a Business Process Management tool is in production, it generates useful data that helps the business analyst to understand and measure cycle time. The data generated by the workflow environment allows him or her to identify what activities and subprocesses take the most time or use the most resources. In other words, a Business Process Management tool offers you the data that you need to decide where you can improve your business processes, what the costs are, and what benefits can be expected. The underlying forces that push a company to Business Process Management are technology, globalization, and consumer and competition power. Technology has removed time-zone and place restrictions, creating a global marketplace at all times. But technology has also given consumers the power to leave your business with a single-click of the mouse. Technology has also increased the power of the competition. They too can go away with a single click and operate globally to reduce cost and cycle time.



1.3 Process architecture A business process is a sequence of multiple smaller parts that we call subprocesses. Subprocesses can be seen as reusable business services. For example in an order entry business process, you will find a step to identify a customer. As input you could have the customer number and as output the shipping address and other details.
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Process Architecture
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Process Participants Customers Employees Figure 1. Layering of a business process



The subprocess used to inquire about a customer could be reused in another business process, for example the processing of incoming payments. A subprocess on its own can consist of the integration of multiple applications running on different systems. A subprocess is then a sequence of actions in a message flow. In a first node of the customer inquiry subprocess, you take the customer number as input and get shipment information as output. In the second node, the shipment address is used to find out what the preferred shipping company will be, based on the region where your customer is located.
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In each node of the message flow, you use adapters and connectors to link from the message flow to a back-office application or database or to an end user. The initiators of a business process can be customers, partners, suppliers, employees, or applications. This three-layered split in the architecture of reusable business components can also be seen as 1. Process flow and process management 2. Information flow and application integration 3. Data flow and application connectivity The process flow consists of data associated with the business, such as customer number and list of order. The information flow consists of data that is not relevant at the business level, but data that is needed to make it work. You cannot deliver the goods without knowing what the shipping address is or who will make the shipment. The data flow consists of any data that is needed to run the business process within the IT infrastructure. For example, it consists of data exchanged by the workflow servers that control the execution of the business process. Using the terminology of MQSeries Workflow, the process flow data is what you will pass in the input and output container of a work item.



1.4 Process modeling Modeling the processes of your business captures the corporate knowledge. Traditionally, the assets of a company are land, labor, and capital. But a new asset type, information and knowledge, is becoming increasingly important. Most people consider information to be the data about the company’s services and products, its customers, and suppliers. But very often forgotten is the information and knowledge of how the business is run. To exploit this information, or perhaps even more important to keep and maintain this knowledge and information, you need to structure and format it. A process model is a powerful tool for structuring and formatting company information. One immediate advantage is the visibility of the business rules, which makes it easier to adapt them to changing market conditions. Also, thanks to the process model, you see what happens in your business and why. Another advantage of a formalized process model is the guarantee that processes will be executed in a repeatable, consistent, and precise way. Errors are avoided and customers don’t get frustrated. Every process instance follows the same rules of execution.
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The art of designing and modeling business processes can fill a whole book on its own. Different approaches exist, and in general it is the responsibility of a business analyst and not the IT specialist or architect to analyze and model a business process. In this redbook, we start the process modeling task from the point where business process information has been captured by the business analyst. A graphical modeling tool can be used to build a prototype to assist in bridging the gap between the business analyst and the IT architect. In the very first prototype of the business process, all activities are performed manually and staff selection is skipped. Ideally, the activities are dummy programs that allow you only to view the input data and to set the output data. That makes it possible to check all exit and entry conditions. You can then also easily validate all execution paths in the flow by using the right set of input data, but without real processing. Consider this technique as unit testing at the workflow level. Then, the process model is refined step-by-step by integrating applications at the different steps. That integration can be via point-to-point messaging or using an information broker. When all applications are defined in the flow, the human interaction is further refined by defining staff members and roles and staff selection. All these tasks are done in a workflow modeling environment. These processes will be instantiated and executed in a workflow runtime environment, where work items will be distributed, staff may be assigned, and the process execution will be monitored.
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Chapter 2. Introducing business-to-business (B2B) Business-to-business is now excessively hyped in the popular media, whereas business-to-consumer (B2C) was once all the rage but has died almost completely. In this chapter, we introduce the business-to-business concept and explain how it is different from business-to-consumer, what the requirements are for a B2B system, and why B2B will not follow the same path as B2C did, simply because B2B has always been there. Thanks to the Internet, B2B is now taking the next step and is open to more companies than ever.



2.1 What is B2B? Business-to-business is about more than just relationship management. It is also more than just buying some goods or selling products to other companies. It’s about integrating external companies within your own business processes. Examples of business processes that could exploit a B2B infrastructure include: 1. Collaborative product development During the development of a product, the design can often be changed when the specification of components change. The components that are designed and built by your suppliers may still be in a design phase as well. By integrating the design and test cycles of your products with the design and test cycles of your suppliers, you can shorten the complete cycle time of your product. This clearly reduces the total expenses of the product cycle, but maybe even more importantly, it reduces the time that is needed to bring your products to the marketplace. As an example, take the product cycle of a computer assembly company. During the product cycle, it is critical that you stay informed about the specification of the motherboard, to name one component. And at the same time, the producer of the motherboard will be highly interested in your test results. 2. Collaborative planning, forecasting and replenishment An important aspect of controlling your expenses is controlling your inventory. By sharing your sales forecasts with your suppliers, your suppliers can better control their production planning and control their inventory. This leads to lower prices for you, as their customer. An often-used technique to reduce temporary overstocks is a promotional action. By planning these promotional actions with your suppliers, they
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can increase their sales forecasts and make sure that you do not run out of stock during the promotional action. Consider again our example of a computer assembly company. When it plans a back-to-school computer purchase program with reduced prices for college students, it makes sense to share this information with the producer of the motherboards to make sure that his manufacturing planning is aware of a possible spike in sales. 3. Procurement and order management This is probably the most obvious application in the B2B space. Up-to-date information about your orders is critical to make sure that you can make your promises to your customers. If the computer assembly company is at the point of closing a major deal with a retailer, the product planners need to make sure that the motherboard company is able to deliver the motherboards on time. Maybe even more important is an integrated order mechanism. It’s fine that you inform the motherboard company about your deal with the retailer and that the B2B system automatically orders the needed motherboards. But what about the other components of the computer? To make sure that you have enough cases (or CD readers or whatever), your B2B system needs to have an automated replenishment. 4. Operations and logistics Another aspect of the integrated supply chain is the delivery process and warehousing. Tracking your order of motherboards cannot stop at the point where the producer says: it’s shipped. You need to know where it is, in what stage of the shipping process and when you can expect the product at your door. Only then you are able to pass correct information to your customers who are calling about their orders. 5. Quality and customer service Integrating the customer service processes of your suppliers into your own customer service processes increases again the level of quality and responsiveness of your customer service representatives. At the same time, it increases the level of satisfaction of your customers. Consider an end user who calls the computer assembly company about a defect in his computer. Wouldn’t it be nice if your customer service representatives could immediately pinpoint the cause to be a known defect in a component of your supplier, a defect in the motherboard for example? This can only achieved if your customer representatives can access that information from your motherboard supplier instantly and seamlessly. 6. Reducing operating costs
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This sounds a bit like the general theme in B2B. Basically, the idea is to cut costs for normal processing, processing that can be automated, that can be handled in a closed loop. Concentrate your human efforts on the exceptional situations, which is management by exception. When you go through this list, it is clear that B2B is nothing new. Companies have done this for years. What is new is the level of integration between all these possible applications. In the past, companies used mail or faxes to pass orders to their suppliers. Some more advanced companies used data exchange mechanisms, for example electronic data interchange (EDI), to integrate operations between themselves and their suppliers. B2B, as it is known today, means not simply passing information or exchanging data, but collaborating within a shared business process, shielded from private processes within your company. It is also clear that these applications require more than a browser-based interface where an end user is entering some order data to be sent to a supplier. B2B has two ways of connecting a set of enterprises. In its simplest form it is a representative of one company using a browser. In its more integrated form, it is a direct communication between IT systems of a set of companies, without human intervention. A B2C environment is typically limited to the first style of communication. Another differentiator between B2C and B2B is the business protocol or better business control. In a B2C environment, the provider of goods or services will set out the rules and the consumer can either accept them or go somewhere else. In a B2B environment, the control of the process is spread out over all participants (peer-to-peer) or can also be centralized. To summarize, B2C is only a subset of B2B. B2C transactions are normally short running and simple (order placement, catalog access), while B2B transactions can span longer periods of time and can be much more complex. Finally, the introduction of automated operations or system-to-system transactions make B2B different from B2C.



2.2 Requirements for B2B Business-to-business is a natural follow-up to Enterprise Application Integration (EAI). Looking at the examples in the previous section, it is clear that B2B can only work if the computer systems of the computer assembly company are all linked to each other and if the applications work together. However, it is not sufficient to extend your EAI solution with, for example, an XML adapter or an EDI product to make it a full B2B solution. A simple XML
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adapter may be sufficient for simple data exchanges, such as transferring a daily bulk order to the motherboard company. What is actually needed is business process tooling, partner management, and change management. The EAI solution needs to be extended with an environment in which you can describe the business process in a formal and complete way. It needs to be aware of your partners and of the fact that they can have different levels of partnering and information sharing. It needs to have an environment where change management is built in and easy to perform. It doesn’t make sense to build a B2B solution that is static, simply because the economy - your business - is not static. You need to be able to add new partners instantly, change the flow of a business process, or even change a business process to switch to another partner, without disrupting your internal applications. Using our example in the previous section, you need to have the ability to switch to another motherboard supplier without impacting anybody or any application in your IT environment. You may have the best and most integrated suite of tools as a B2B platform. However, if your partner sticks to e-mail or FTP-based operations, you have no option other than using that communication mechanism. The point is that any acceptable B2B solution cannot limit itself to one way of collaboration. And if your partner finally acknowledges that there are smarter solutions than a fax, it should again not impact your IT operation. Thus, a B2B solution should have many possible channels to interact with your partners, from such low-value solutions as e-mail and fax, to medium-value solutions such as browser integration and EDI, to high-value shared process management solutions. This requirement for flexible process management, partner management and channel management adds to the well-known requirements for enterprise application integration tools: 1. Heterogeneous systems Within a single enterprise you will already find a wide range of systems and platforms that have grown over time. This not only includes hardware platforms but also the business process control environment. There is no single ERP package that controls the world. There is no single framework (COM, CORBA, EJB, messaging) that has conquered all your partners. A B2B system, such as an EAI system, has to be able to cope with as many of these as possible. 2. Differences in data representation This is not only about data formats, about XML versus fixed offset layouts, or comma-separated formats versus tagged formats. This is also about
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how to represent a customer, how to represent an invoice, how to represent any business object. People who have some experience with these things will know that you can have long, often political and philosophical discussions within a single organization. You cannot assume that those discussions in different companies have led to the same conclusions. Your B2B system will need to have a way to map a business object of company A onto a business object of company B. 3. Different cultures and ways of doing business An enterprise is like a human being. Every human being has his or her own way of living. Some like it hot, some like it cold. And do not ask them to change that. When your company wants to interact with its partners, the last thing you should ask them to do is change their business processes. They know how to handle orders, they know how to manage their inventory, they know how to design their products and how to handle the product cycle. In other words, your B2B system should not impose changes in the way your partner operates. It can, of course, but it should never depend on it. This leads to something that is commonly known in software engineering: encapsulation and public interfaces. The way you operate as a company is shielded or encapsulated in your private business process. How you talk to your partners is the public interface or the shared process. A B2B system should be able to make this distinction. That also means that any change in your private process should have no impact on the public interface. Similarly, a change in the implementation of a method in object-oriented software engineering should have no impact on the public interface. 4. Business dynamics The IT world is known for its dynamics. Standards come and go. Products that were taught to be the holy grail disappeared. However, it is less known that business in general is very dynamic. And just like the IT business, the dynamics are increasing, the speed of change is increasing. What is even less known is that business managers are often limited by the IT systems in their abilities to adapt to the dynamics of their industry segment. In many companies, business managers are knocking on the doors of the IT department to push new applications and to change the interaction between applications. This pressure will even increase in a B2B system, and it is therefore critical for the success of any B2B system that it be capable of handling constant change. Change management must be an integral part of the B2B solution, not an optional add-on. 5. Security and reliability We take this almost for granted. No B2B system can survive the pilot phase if it is not reliable or secure. No order, how small it is, can be lost.
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An order can only be fulfilled if you know for sure who your partner is, if you know for sure that the received order is the order that was intended. In other words, your B2B has to support data encryption, non-repudiation, authentication, and data integrity.



2.3 Components in a B2B solution Given the list of requirements that were outlined in the previous section, it is clear that building a B2B solution is not an easy task. Let’s break it up in a few components and see what options are available at each level.



2.3.1 External communication mechanism By its nature, B2B involves communication with external companies. Two aspects are important to consider: the mode of interaction between organizations and the way that agreement is reached about a business transaction. 2.3.1.1 Interaction mode When a company has relationships with many partners, a wide range of interaction modes can be in place. • Web client access The browser access is a method that is very familiar today and provides an easy way for business partners to share information. In this approach, a representative of one company uses a browser to interact with a Web server application hosted by a partner business company. • Data exchange This approach has also been popular for a long time. A number of variations exist, such as EDI, consisting of X12 and EDIFACT data sent over a value-added network (VAN). Other forms are FTP and e-mail with attachments. In each case, the focus is on exchanging data sets. • Direct application integration In recent years, enterprises have built up experience with middleware technologies, such as distributed object technology, message queuing, and publish/subscribe brokers, to exchange information between applications. It is possible to extend these technologies to exchange information between enterprises. However, this means that all enterprises need to commit to the same technology, which sounds difficult to achieve.
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• Shared processes Shared processes are an extension to simply exchanging information. They allow you to include agreements on the set of exchanged messages that are used to handle acknowledgements, exceptions and so on. RosettaNet is a well-known example of this concept. RosettaNet’s Partner Interface Processes (PIPs) defines the information and agreements, for example to handle ordering, including back orders, changes to orders, and any logic that is required. RosettaNet was originally developed in the supply chain management process for electronic component and computer business. Two other parameters play a role in the selection of one technology versus the other. • Level of synchronicity The more synchronous the integration is, the closer you get to real-time or nearly real-time interactions. Direct application integration is the most synchronous mode of interaction. Web client access is an example where the interaction is very asynchronous. • Level of independence or autonomy The choice of a technology can limit the freedom of enterprises to handle their business. You could easily implement a solution that requires such a strong level of agreement, joint development and complexity that the advantages of integration are outpaced by the limitations. 2.3.1.2 Agreement mode A very sensitive aspect of enabling a B2B solution and making it acceptable by the business community is how an agreement is achieved over a business transaction among the trading partners. Agreement about business transactions is often linked to industry or government standards. There are many standards that play a role in the B2B environment. For an overview of standards, refer to 2.4, “Standards in the B2B marketplace” on page 17. Some of these standards are still under evaluation, while others have been in use for quite a while or are used in other parts of the IT industry.



2.3.2 Internal communication mechanism A business-to-business solution also needs a mechanism to communicate with the internal applications of an enterprise. These applications need a way to pass information to the B2B solution, when something needs to be passed to an external partner. And the B2B solution needs a communication path to pass information received from partners to the internal IT systems. There are a number of communication techniques, some primitive and others complex .
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But not only the B2B solution needs an interface. The internal business applications must have an exposed interface. Without these, you cannot create an automated linkage between your systems and those of your partners. 2.3.2.1 Procedural APIs This is probably the most common technique for communication with a software package. Exposed functionality is provided as a number of callable functions or procedures. 2.3.2.2 SQL/DML interface In this case, the application has documented the layout of its internal database. Using the application-independent data manipulation language SQL, you can communicate directly with the application. 2.3.2.3 Messaging Messaging APIs, offered by IBM MQSeries, provide an easy way to capture or signal application events. Given the broad platform coverage of MQSeries, you can reach almost any business application. 2.3.2.4 Object APIs Recently, application vendors have begun to use modern object oriented technology to expose functionality of their products. Commonly used object technology frameworks include Microsoft’s DCOM, Enterprise JavaBeans and CORBA, defined by the Object Management Group (OMG). 2.3.2.5 File-based API Legacy systems often have only a file-based API, where files are imported or exported to introduce or share information. This technique is suitable for batch-oriented systems. For event-driven interaction, a file interface is not so suitable. 2.3.2.6 User session emulation This technique is often the last one that an enterprise will use, because the application has no other interface. It consists of driving the user interface of an application in programmatic ways. It is a very complex approach that is difficult to maintain.



2.3.3 Process and information coordination Probably the most important component of a B2B solution is the process coordination, the component that bridges external and internal communication. This information broker or process broker needs to
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synchronize the external and internal communication and needs to maintain process state information. Processes can run for a very long time, up to several days. Keeping the process state consistent is then a key requirement. Another aspect is the information transformation. It’s very unlikely that the exchanged information will always be in the same format. Maybe you can initially agree on the format of the exchanged messages, but it is very likely that a partner is going to change the format at some point. If you use that same format in your external applications, you will be forced to adapt your applications. A better and more manageable approach is an information broker that shields you, and your partner, from changes in the message format. Introducing the changes in a broker is a much simpler task than updating your applications.



2.3.4 System management A B2B solution very often has a big impact on your company and its employees. An appropriate management system of the B2B solution can remove some of the doubts that people may have. That not only means manageability at the systems level, but also and even more importantly the ability to manage the relationship with a partner, to manage the communication path with a partner, or to manage a process instance. What is most important is to make sure that the B2B solution is accepted as a critical tool for your business.



2.4 Standards in the B2B marketplace B2B solutions operate in a heterogeneous environment. Several standards have been established for each component of a B2B solution. However, it should be noted that many standards exist and that a B2B solution should be able to handle many different standards, so that your solution does not impact a business interaction with a possible partner, simply because there is no common, or no single, standard that could link your company with theirs. But, at the same time, a set of standards will not be sufficient to help you solve the problem. The development of standards is very often a lengthy process and the standard can be outdated by the time it gets accepted. The speed of change in the business world has outpaced the speed of development for standards. Also, standards in the B2B arena tend to be vertical oriented. Some standards are specifically designed for a specific sector and can get some use outside that economic segment. But then again, the standard can become a limitation instead of an advantage. If you are a car manufacturer and implement a B2B solution based on standards for your
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industry, how will you interact with companies outside your segment? After all, you need more than screws and wheels to assemble a car. Nevertheless, we feel that standardization is the way to go. Building a B2B solution based on a proprietary approach is risky. You can end up doing business on your own island, with no way to communicate. The standards initiatives and industry consortia are organized at four levels of communications: metadata, content, transport, and process. Some initiatives have standards at multiple levels, such as RosettaNet or OAGIS. And, to make things complicated, at each level you have multiple standards. While things are moving towards consolidation, an enterprise should consider as many standards as possible to minimize the risk of being on the wrong side after some time.



2.4.1 Metadata: XML versus EDI Sometimes you will hear the argument that XML in a B2B environment is just another three-letter word for EDI. There are indeed some similarities, since both standards operate at the metadata level. Both are specifying an abstract format for representing data. Metadata defines the structure of data and character sets of data to be used in transmission. When comparing XML with EDI, a principal difference is that XML is used in many more environments than just business-to-business communication. EDI is indeed focusing on that. The fact that XML’s usage is much more widespread is indeed an important advantage. EDI’s style of communication is more batch-oriented over a closed value-added network (VAN). XML documents are typically intended to be sent in real time over the Internet. Another way of comparing EDI with XML is by comparing a procedural language such as COBOL with object-oriented languages. EDI had one-to-one connectivity in mind, where both parties agreed on the contents to be exchanged. The contents are organized like a structure in C, or a copybook in COBOL. On the other hand, XML has one-to-many connectivity in mind. An XML document type is like a class that has some core functionality. Anyone is free to extend the XML document, but the core information remains the same, just like you can sub-class a class in an object-oriented language. The sub-class adds functionality while maintaining the existing functionality. For example, an XML document for a purchase order has a defined set of fields, but you can define an industry-specific purchase order that adds fields that are industry-specific.
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Many enterprises have significant investment in EDI-based solutions. It is therefore no surprise that it will take some work to merge the two technologies. The group XMLEDI is working on interfaces that accommodate both.



2.4.2 Content standard: introducing Business Object Documents First, let’s clarify the abbreviations, some variations of which refer to the same entity. OAG stands for Open Applications Group. Sometimes, the organization is referred to as OAGI, which stands for Open Application Group Incorporated. The specification is known as OAGIS (Open Application Group Integration Specification). The Open Applications Group is a non-profit consortium focusing on best practices and process-based XML content for e -business and application integration. Their mission can be seen as developing high-quality business content and XML representations of that content. The Open Application Group has created specifications at the content level. These are known as Business Object Documents (BODs). A BOD specifies what fields are to be present in an XML document that is exchanged between business partners. At the highest level, a BOD has two fields: a Control Area and a Business Data Area, as illustrated in Figure 2.



Figure 2. Architecture of a BOD
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Each BOD contains one unique Control Area. The three major components of the Control Area are shown in Figure 3. The combination of Business Service Request (BSR), Sender, and DateTime creates a Global Unique Identifier (GUID). The GUID is to be used for security, transactional integrity, reporting and exception handling, confirmations, and re-sending.



Business Object Document Control Area Business Service Request Verb Noun Revision Sender DateTime



Business Data Area



Figure 3. BOD: components of the Control Area



The BSR is the action that the sender application wants the receiver application to perform. The BSR is constructed of a verb, a noun and a revision. The verb is the action keyword of the BSR. Some possible verbs are: • • • •



get create sync add



The noun indicates the object on which the verb has to be performed. Some possible nouns are:
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• • • •



RFQ (Request for Quote) Prodorder BOM (Bill of Material) PO (Purchase Order)



The revision is used to identify the BSR version. Each BOD has its own revision number, which is a three-digit field starting with 001. Combining these three elements, you can have the following BSR of a BOD: add PO 006



The Business Data Area (BDA) of the Business Object Document contains all the codes, parameters, and values needed to support the Business Service Request. For example, to send a Purchase Order or Orders to a business partner, the Business Data Area will contain all the header and line information for all of the lines representing items to be purchased.



2.4.3 Transport level: SOAP Simple Object Access Protocol (SOAP) is a communications technology, specifically, and message enveloping mechanism based on XML (eXtensible Markup Language). SOAP was developed jointly by IBM, Microsoft, and several other companies and has been submitted to W3C for standardization. A major application of SOAP is to allow businesses to link their computing systems over the Internet in a platform-independent manner. The SOAP spec is at http://www.w3.org/TR/2000/NOTE-SOAP-20000508/ Applications that implement e-business solutions need to communicate with each other over the Internet to be useful. Since there are many ways to write these applications, and many platforms on which they might run, there is a real need for inter-application communication standards that are independent of these differences. SOAP is the foundation and first member of such a family. Unlike other distributed computing techniques, such as Java RMI or OMG's CORBA, SOAP messages can be carried over HTTP. A major Internet implication of this is that SOAP can traverse firewalls. This is a mixed blessing. Deployment and collaboration between network-connected parties is easier, but traversing the firewall with SOAP messages can be considered a security risk. SOAP, based on XML, provides a framework for connecting Web sites with applications to create Web services. SOAP provides a simple and lightweight mechanism for exchanging structured and typed information between peers in a decentralized, distributed environment using XML. SOAP does not itself
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define any application semantics such as a programming model or implementation-specific semantics; rather it defines a simple mechanism for expressing runtime interface syntax by providing a modular packaging model and an encoding mechanism for encoding data within modules. It provides a framework for creating electronic envelopes, including ones that can be sent through HTTP, so corporate firewalls do not stand in the way. This allows SOAP to be used in a large variety of systems ranging from messaging systems to RPC. All SOAP messages are encoded using XML. A SOAP message is an XML document that consists of a mandatory SOAP envelope, an optional SOAP header, and a mandatory SOAP body. This XML document is then referred to as a SOAP message.



2.4.4 Transport level: ebXML ebXML is an International Initiative established by UN/CEFACT and OASIS in late 1999 with a mandate to research and identify the technical basis upon which the global implementation of XML can be standardized. The goal of ebXML is to facilitate open trade between organizations regardless of size by enabling XML to be used in a consistent manner to exchange electronic business data. ebXML is a set of specifications that together enable a modular electronic business framework. The vision of ebXML is to enable a global electronic marketplace where enterprises of any size and in any geographical location can meet and conduct business with each other through the exchange of XML-based messages. ebXML is a joint initiative of the United Nations (UN/CEFACT) and OASIS, developed with global participation for global usage. UN/CEFACT is the United Nations body whose mandate covers worldwide policy and technical development in the area of trade facilitation and electronic business. The Organization for the Advancement of Structured Information Standards (OASIS) is a non-profit, international consortium that creates interoperable industry specifications based on public standards such as XML and SGML. OASIS members include organizations and individuals who provide, use, and specialize in implementing the technologies that make these standards work in practice. The specification of ebXML can be found at http://www.ebxml.org/specdrafts/approved_specs.htm.
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2.4.5 Transport: AMI OAG has approved the IBM Application Messaging Interface (AMI) as an implementation of its own Open Applications Group Middleware API Specification (OAGMAS). The idea is either an application software vendor or an end-user company can write to a common middleware API, but then use a variety of middleware for transport. In the case of the OAGI's Business Object Document (BOD), XML will define common ways for disparate applications to share data. IBM's AMI defines the high-level interface for controlling how BOD documents are transferred with message-queuing middleware.



2.4.6 Process level: WfMC The Workflow Management Coalition (WfMC) is a non-profit organization of vendors and users of workflow management systems. The Coalition’s mission is to promote workflow standards for workflow management systems to allow interoperability between different implementations. WfMC is a part of ebXML and is working on a meta-standard for trading partner agreements. Their XML based process management standard includes work on OAGMAS, which is an OAGIS specification. Earlier work from WfMC consists of the Workflow Reference Model. This includes standards for process definition, workflow client APIs, an interface for workflow invoked applications, workflow interoperability specifications and audit data specification. MQSeries Workflow’s flow definition language (FDL) is based on the standards of the Workflow Management Coalition. WfMC has also a Wf-XML binding standard that implements the workflow interoperability specification.



2.4.7 Process level: BMPL Business Process Modeling Language (BPML) is defined by the Business Process Management Initiative (BPMI). BMPI is a consortium of several companies to standardize the management of mission-critical business processes that span multiple applications and enterprises. The XML-based standards generated from the initiative will support and complement existing B2B collaboration protocols such as RosettaNet, BizTalk, and ebXML, as well as technology integration standards including J2EE and SOAP. BPML is an XML schema that provides a standard way to model mission-critical business processes. By covering many dimensions of business process modeling that are specific to processes deployed internally to the enterprise, including business rules, security roles, distributed
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transactions, compensating transactions, and exception handling, BPML will bridge the gap between legacy IT infrastructures and emerging B2B collaboration protocols such as RosettaNet, BizTalk, and ebXML. The BPML will enable the enterprise to model, deploy, and manage business processes such as order management, customer care, demand planning, product development, and strategic sourcing. This will allow the IT infrastructure to enable the adaptive enterprise that can manage constantly evolving business processes. A TPA document contains the following information: • Overall properties This includes TPA name, starting and possibly ending dates for validity of the agreement, and other global parameters. • Role and identification This identifies the parties to the TPA as logical roles such as buyer, seller, airline, hotel etc. Specific organization names and contact information such as e-mail and postal service addresses are then provided for each role. The allowable actions under a TPA are organized by role making. It easy to modify an existing TPA to specify identical interaction rules but with a different partner. An optional role is that of external arbiter for use in resolving disputes. • Communication and security These attributes specify the communication and interaction protocols to be used. The specification is layered into transport, message handling, and higher level conversational sections. Protocol choices and parameters for addressing security including authentication, certificate handling, and nonrepudiation are included. • Action and sequencing For each identified role, this is a menu of the actions that can be performed on request from the partner. A signature is specified for each action defining the parameters and their data types. Sequencing rules specify constraints on the order in which actions can be requested. In the case of a travel agent process interacting with a hotel, example actions would be requests to make a room reservation and subsequently to modify it. • Cancellation and error handling The cancellation rules indicate whether the result of a completed action can be cancelled, and if so, the constraints under which such a
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cancellation is permissible. Error handling rules manage error conditions (for example, the maximum waiting time for the response to a request). Commentary text can be added to the TPA to cover other negotiated but not processed issues.



2.4.8 Cross-level: Trading Partner Agreements Trading Partner Agreements (TPAs) are XML-based documents used to specify the business interaction between business partners. A TPA defines how trading partners will interact at the transport, document exchange, and business protocol layer. TPAs are declarative documents and specify these roles and responsibilities as a set of attribute value pairs. The document is completed by providing specific attribute information for a particular pair of interacting trading partners. A business uses a TPA document to define the agreed model of interaction with a specific trading partner. The TPA represents a single long-running conversation, consisting of a set of related interaction steps, distributed over time but comprising of a single unit of business (UOB). TPAs operate within a Business-to-Business Protocol Framework (BPF) that provides a comprehensive tool set for the specification, configuration, customization, and execution of electronic contracts between business partners. The TPA simplifies the specification of a business-to-business interaction by organizing the information into separate functional layers. Data flow through the runtime layers is governed by specifications in the TPA. This layering provides appropriate abstractions for business data flow and minimizes the need for specialized coding. The functional layers specified in a TPA and supported in underlying BPF runtime processing are: • Transport layer, which handles the selected transport protocol, network connection and basic security. • Document exchange layer, which provides document abstraction, including message data mapping, nonrepudiation, time-stamping, logging and audit. • Business protocol rules and interface layer, which provides message sequence and responsiveness checks, document type and trading partner-specific data handling, together with interface logic to connect to specific local business applications.
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2.4.9 Cross-level standards: RosettaNet RosettaNet started as a vertical solution to achieve interoperability within the electronics industry, at the process level with Partner Process Interface, and at the transport level with RosettaNet Implementation Framework (RNIF). While originally intended to standardize at all levels of B2B communication, RosettaNet is now working to use OAGIS at the content level and ebXML at the transport level. The Partner Process Interfaces (PIPs) are specialized system-to-system XML-based dialogs that define how business processes are conducted between IT manufacturers, software publishers, distributors, resellers, and corporate end users. RosettaNet PIPs are designed to enable the standardization of e-business processes among buyers and sellers in a supply chain. PIPs are grouped in eight clusters of core business processes. Each cluster is broken down into segments for cross-enterprise processes involving more than one type of trading partner. Within each segment, you can have several PIPs. RosettaNet has defined the following clusters: 1. Cluster 0: RosettaNet Support: Provides administrative functionality 2. Cluster 1: Partner, Product and Service Review Allows information collection, maintenance and distribution for the development of trading-partner profiles and product-information subscriptions 3. Cluster 2: Product Information Enables distribution and periodic update of product and detailed design information, including product change notices and product technical specifications 4. Cluster 3: Order Management Lets partners order catalog products, create custom solutions, manage distribution and deliveries, and support product returns and financial transactions 5. Cluster 4: Inventory Management Enables inventory management, including collaboration, replenishment, price protection, reporting, and allocation of constrained product 6. Cluster 5: Marketing Information Management
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Enables communication of marketing information, including campaign plans, lead information, and design registration 7. Cluster 6: Service and Support Provides post-sales technical support, service warranty, and asset management capabilities 8. Cluster 7: Manufacturing Enables the exchange of design, configuration, process, quality, and other manufacturing floor information to support the "Virtual Manufacturing" environment



2.4.10 Cross-level standards: cXML cXML is a proprietary framework created by Ariba. It specializes in simple transactions for highly fragmented business structures that dynamically transact business. Ariba is moving to integrate its framework within BizTalk.



2.4.11 Cross-level standards: xCBL Commerce One is another company that has built its proprietary framework based on XML. It specializes in complex transactions with low volume among organizations that use negotiated agreements on transactions.



2.4.12 UDDI and Web services Web sites can offer some services, such as ordering material to be used in the manufacturing process of a car. If a company wants to buy that material electronically, it has to know how to interact with that supplier. Universal Description, Discovery and Integration (UDDI) aims to automate that. The UDDI registry is similar to a phone book. It lists what companies do business electronically, what they offer as a Web service, and how to interact with them. Web Services Description Language (WSDL) is an XML language specification that is used to describe a company’s published interface and services. Using SOAP, companies can then invoke the published Web services. Thus, using SOAP, companies can query the UDDI registry to search for a specific service. The UDDI registry replies with a WSDL message to describe a company that provides the requested service and how to invoke them. Finally, the requesting company uses SOAP to send the request to the providing company to get the intended service. The information provided in the UDDI registry is organized into three levels. The White Pages data contains general contact information about the company, including contact names, phone numbers, addresses, and Web site addresses. The Yellow Pages data provides information about the available
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products and services and geographical information. Finally, the Green Pages provides information on payment options and technology options. The Green Page entry for a company might, for example, specify that a company can accept purchase order requests using the RosettaNet protocol. UDDI, an initiative from IBM, Microsoft and Ariba, is supported by many vendors. A similar initiative for UDDI is e-Speak from Hewlett-Packard, which has not joined the UDDI initiative.
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Part 2. Example of a Business Process Management solution In this part of the book we discuss the design and implementation of a business process. We look at how MQSeries Workflow and MQSeries Integrator work together to provide an integrated application that handles a customer request. The application has different layers of data exchange. At the highest level, there is a flow that is modelled in MQSeries Workflow. For each step in the flow, or node, data is exchanged that relates to the process. At a lower level, MQSeries messages are exchanged between the applications, possibly passing through MQSeries Integrator.
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Chapter 3. A business case: insurance claim processing In this chapter we describe the application that we will develop over the next few chapters. After a business view of the application, we explain what technologies will be used and how these are linked to each other.



3.1 Car insurance accident reporting The application that we will construct is a car insurance accident reporting application. When someone has a car accident, he will typically call his insurance company to solve his immediate problems: towing the crashed car to a repair center, getting a replacement car, and maybe finding some temporary lodging, depending on where the accident happened. The most common way to contact the insurance company in such a situation is by phone. A call center agent will take the call and enter the accident date in a database. However, Internet access should be an option, too. If the car owner has, for example, a WAP-enabled mobile phone, he should be able to report his car accident and get the same level of service as if he had called the insurance company. In this redbook, the WAP solution will not be developed, but it should be clear that the application could have other interfaces and users in the future. The interface for a call center agent should not be the only starting point for the application. When the accident data is entered in the system, the application finds out what services can be offered to the owner of the car. These services include car rental, car towing to a nearby repair center, and lodging if required. The available services are determined based on the terms of the insurance contract and the history of the owner. If he should have a bad record, the approval of a supervisor is required before any services can be offered. When the car owner wants a rental car - if he is eligible to get one - a request is sent out to a car rental company to deliver a car at the place of the accident. Based on the location of the accident, the nearest towing company is contacted to drop the damaged car at a repair center.



3.2 Designing a solution When designing this application, we assumed that a real-world insurance company would not run its business on a single platform or system. We assumed a customer database where personal data about all customers is stored. We included a product database where a history was kept about a
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given insurance product, a database where you would store the claim data and where you can manage the profitability of the car insurance product. One can also easily imagine a database that contains information about external partners: data about accredited car repair centers and towing companies, contact information for car rental companies and links for hotel reservation. Instead of starting to link all these systems to each other and see where we are after that to determine the next step, we choose a top-down approach. What is the business process to solve, what steps exist in that business process (the subprocesses), and how do we go from one step to the next? At the highest level of abstraction, you can identify the following steps in the process: 1. Identify the customer 2. Record the details of the car incident 3. Check if an approval is required based on the customer’s track record 4. Determine what can be offered to assist the customer and what the customer needs 5. Contact the external companies to deliver their services to the customer
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Customer ID



Request Customer Details



Retrieve Customer Details



Details Correct? ______________ No



Receive Claim Number



Send Incident Details



Yes



Send Extras Request



Receive Confirmation



Approval Required _____________ Yes



No



Request Approval



Approval Received _______________ No



Yes



Figure 4. Different steps in the application



The customer identification process consists of providing some input from the customer and looking up his complete record in the IT systems of the insurance company. This identification can be seen as a reusable business component, a component that encapsulates the cross-linking of different database systems.
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MQSI Message Flow



MQWF RequestCustom erDetails.exe



Send Custom er ID to Back-end System REQUEST.CUST OMER.DETAILS



Look up Custom er Details RetrieveCustome rDetails.exe



Retrieve Custom er Details from Queue REPLY.CUSTOMER.DETAILS



Do not proceed with claim



no



Are these Details Correct ?



fmcsiyes.exe



fmcsiyes.exe



yes Continue (2) Figure 5. Customer identification subprocess



Once we know the customer, we enter the subprocess to collect data about the actual car incident. As explained, this information will be stored in a number of places. The customer history database will be updated, the product history database will be affected, and maybe some other back-office processing needs this information. That information distribution is again a reusable business component. At the business level - that is at the workflow level - you’re not concerned about this distribution. This subprocess calls for another reusable business component. Before the call center agent can proceed to the next step, we need to make sure that this customer is still eligible for extended service.
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MQSI Message Flow



MQWF GetIncidentDetails.exe



Update Customer Details



Get the details of the accident from customer REQUEST.CLAIM.NUMBER fmcsiyes.exe



Determine Approval Conditions



Advise Customer RetrieveClaimNumber.exe



Receive claim number and approval flag from back-end system



fmcsiyes.exe



Send aproval request to claims manager



REPLY.CLAIM.NUMBER



Is approval required ?



yes



no



Approval Received ?



Create Claim Record



yes



no



Continue (3)



Figure 6. Incident details recording subprocess



In the next iteration, the call center agent records the services that the customer wants to use. These requests are stored again in a number of places. The cost of the services is stored in the product database and the customer history database. If the services are provided by some external companies, the ordering of these goods needs to be tracked and these companies need to be informed about these requests. Again, these actions are a set of reusable business components that are called upon out of the workflow.
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MQWF



MQSI Message Flow



SelectExtras.exe



Get the details of emergency extras required from customer



Update Customer Details REQUEST.EXTRAS.DETAILS



Send Requests to External Suppliers



The "Outside World" RetrieveExtras.exe



Advise Customer



Receive Reply from Customer / Update Database



Retrieve the extras information REPLY.EXTRAS.DETAILS



fmcsiyes.exe



Figure 7. Processing the request for extended services



Finally, how does the insurance company collaborate with its suppliers? Using the Internet is an obvious answer because the Internet has the ability to connect everybody. Small and large business partners should all be able to connect to the Internet. It’s open for sophisticated interactions as well as simple browser-based interactions. Partner Agreement Manager offers this functionality. In Chapter 7, “Basics of Partner Agreement Manager” on page 159, we provide an introduction to Partner Agreement Manager. One of the major advantages of Partner Agreement Manager is that it does not impose a technology decision for your partners. Your partners can of course use the same products as the rental car agency does. But the towing company is probably a smaller company that lacks the skills to operate a Partner Agreement Manager installation. It could choose to install Partner Agreement Connect, which offers it the possibility to connect to full installations of Partner Agreement Manager. But the towing company will not be able to define its own interactions or public processes. Another possibility would be that the insurance company deploy Partner Agreement View. In that case, the business process collaboration is available in a browser
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environment. The towing company could actively interact with the business processes of the insurance company by using only Internet access and a browser.



PAM MQSeries



Down Under Insurance Company



Rental Car Agency



MQWF PAM



Hotel Chain MQSeries



PAM



Internet



MQSeries



PAC



Towing Company



MQSI



Figure 8. Linking the insurance company to its accredited partners



Figure 9 links all steps together and shows the different steps in the business process.
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(1)



Send Customer ID



MQSeries SI Q M



MQW F Retrieve Customer Details



Get Customer Details



Details Correct



Send Incident Details



(2) Retrieve Claim Reference



Approval Received ?



(3)



Get Incident Details and Update Customer Databases for Claim Number



Approval Required ?



Send Extras Details



Get Extras Request & Send to External Agencies



Retrieve Extras Confirmation



Get Confirmation of Extras Update Databases



PAM



Figure 9. Overview of the application



3.3 Positioning the different technologies in this application MQSeries Workflow provides the technology to describe and build the business process. The execution engine of MQSeries Workflow will route work items from one step to the other and will make sure that business rules are honored at each step of the business process. It also links background subprocesses to subprocesses that require human intervention. It provides the business view of the claim processing application. MQSeries Integrator has the responsibility to distribute the business requests and data to those systems that require it. This shields the end-user application from the actual location of the different systems. The end-user
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application doesn’t even know that data has to be distributed to multiple systems. MQSeries Integrator plays the role of information broker and at the same time it can make sure that the data is formatted to the needs of the recipient. WebSphere Partner Agreement Manager is the technology to link to external companies. It has the responsibility to respect the business protocol that was set between the insurance company and its partners. MQSeries itself provides the glue to link everything together.
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Chapter 4. Basics of MQSeries Workflow In this chapter we introduce the basic concepts of MQSeries Workflow, and at the components and architecture of the product. Refer to the redbook MQSeries Workflow for Beginners, SG24-5848 for more details.



4.1 What is workflow management? In a workflow environment, a work item can be started for many reasons and it goes through many stages towards completion, until the work item or the request is satisfied. Although most requests seem to be simple, some often become more complex. Many people can be involved, using different information systems. Because of the complexity of the complete processing of a request, it happens quite often that no one in an organization has a complete overview of it and no one seems to have responsibility for the whole process. To create a workflow management environment, you need to manage these three components: • The processes and their logic • The organization and people involved in the workflow • The IT resources that make up your infrastructure A process consists of one or more activities and subprocesses that contain even more activities. Going from one activity to another involves a data flow and a control flow.



4.2 Managing business processes with MQSeries Workflow MQSeries Workflow allows you to design, refine, document and control your business processes. Processes are enforced to achieve ISO 9000 compliance. In the following sections we will go through the steps of definition, modeling, and running a business process.



4.2.1 Terminology We’ve been using several concepts about workflow. It might be a good idea to define now what we mean by each term, specifically in the environment of MQSeries Workflow.
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Process model



The representation of a business process in a form that supports its use by a process management system. This is defined in the Buildtime, imported and translated into a template for use in the Runtime environment.



Activity



Adescription of a piece of work that forms one logical step within the business process.



Process instance An instance of a process model, created using a template, being executed by the process management system. Work item



An instance of an activity, within a process instance, which is assigned to an owner. One or more work items may be created for a given activity instance based on the staff resolution results.



Staff resolution



The function performed by the process management system to determine how many work items (one for each user ID determined to be eligible to perform an activity) will be created when a process activity gets instantiated.



User



Every process and activity in a workflow model is associated with one or more persons, identified by their user IDs. A person can represent an automated client, a physical person, or a team worklist. A team can be seen as a logical person, similar to the concept of a role.



Role



A role is an optional attribute of a user, which can be used to support dynamic staff resolution.



4.2.2 Components of a workflow model The workflow model consists of the interaction between the three major components: processes, organization, and IT resources. Before you can build your workflow model, you need to understand this interaction. You need to know what activities are involved, what the sequence of execution might be, if some of them can be executed in parallel, and if the activities are manual or automated. Manual activities involve human interaction, while automated activities involve the execution of an application program. You also need to understand the data that will be passed from one activity to the other.



4.2.3 Defining your workflow model The definition of a workflow model is done using the Buildtime component of MQSeries Workflow. You draw a diagram of a process model with its different types of activities and you set the properties for all of the components you define.
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If a process definition becomes too complex, you can use process activities to encapsulate subprocesses. This allows you to reuse existing subprocesses in a number of process definitions. You can use subprocesses in two ways. Either you start with a high-level process definition, where each step is refined further as a subprocess. Or you start creating subprocesses as building blocks and link them together until you reach the top-level process definition. Both ways, the top-down approach or the bottom-up approach, work quite well with MQSeries Workflow. MQSeries Workflow uses directed graphs to link items in the process definition. Figure 10 shows a view of the Buildtime component during process definition.



Figure 10. Buildtime user interface



The user interface contains much information. The left pane contains a tree view of your processes. You can use the Processes, Staff, Network, and Implementation tabs to switch to tree views. The staff view contains the definitions for people, groups, and roles. The network tree shows the topology of your Workflow systems. And finally, the implementation view
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shows defined programs and data structures, which describe the information that is passed from one activity to another. These are also referred to as input and output containers. To the right of the tree view, you can see the drawing tool palette, which contains icons for activities and building blocks such as subprocesses. It also has a number of icons that represent different types of connectors. The right pane of the user interface is the work area on which you drop the activity icons and connect them to each other with the connectors. The connectors are the tools that you use to define the process logic. Control connectors can be configured with a condition. When the process runs, the workflow engine will verify the condition to make a decision if an activity has to be started or not. The control connectors allow you to specify the execution sequence in your process definition. There are also data connectors on the tool palette. You use these types of connectors when data has to be passed from one activity to another. This can be as simple as a return code or a complex data structure that describes the details of a customer. You can refer to the data in the condition that you set in the control connector. Once you have specified the execution logic, you need to specify how that is done and by whom. You can assign a staff member to an activity, or a group, or a role. A staff member can have multiple roles, and a role is not limited to staff members of one group. At runtime, MQSeries Workflow resolves the defined organization rules and roles with the specific individuals. It ensures that only eligible people receive the work items. This dynamic staff resolution technique means you do not have to change your process definition when your organization changes. Staff members can come and go, change responsibility, and so on. But a role or an organization unit stays more or less constant over time. You can, if you want, specify names of persons in your workflow model. But this will make the assignment static and it must be changed whenever your staff changes. The next step is to define the business applications and tools that are associated with the program activities. The application is started in the Runtime environment whenever the corresponding program activity gets started. This happens either because someone picks the item in his worklist, or it can start automatically. The applications can reside on workstations or host systems other than the workflow Runtime component.
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Data structures that are passed between the activities in a process are specified by the data connectors. To have these available at runtime, you need to define the properties of the data structures. You can use the basic data structures that MQSeries Workflow provides, such as string, float or long, or you can build nested data structures. Data structures are passed from one activity to another via input and output containers. When the output container from one activity has the same data structure as the input container for the next activity, the Runtime component maps the data automatically from the output container to the input container. However, when there is a difference, you have to specify the mapping of the data structures. The final step in the definition of your workflow is the allocation of IT resources. You need to define the servers in your topology that you want to use during the runtime execution of your processes. For details about the topology of an MQSeries workflow domain, refer to 4.3, “Architecture of MQSeries Workflow” on page 47.



4.2.4 Running your business process When you have completed the definition of your process in the Buildtime component, you should export the definition in a text file. The text file uses a format known as Flow Definition Language (FDL). It is a standard format that is also used by other modeling tools, such as Holosofx. When you import the FDL file into the Runtime component, MQSeries Workflow will check at numerous levels that your process definition does not contain any errors, such as loops for example. Once it is imported into the runtime, MQSeries Workflow creates a process template. It is this template that an end user will use to create a new process instance. The creation of a new process instance can be done by using an MQSeries Workflow Client program. The product comes with a default GUI-based client program or you can use a Web Client to do this. The rich API of MQSeries Workflow can also be used to create a workflow client that fits your needs. The API is available in C, C++, Java, XML, Visual Basic, COBOL and Notes. However, there are some difference in the level of support for each interface. The standard GUI client program has a number of views that we will discuss briefly.
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Figure 11. MQSeries Workflow Client interface



The client interface uses worklists to display pending activities that belong to a defined process. The activities that must be performed by an individual are called work items. The worklist can be updated by the end user to retrieve new items (pull method) or the modeler can force an automatic refresh (push method). The workflow client also allows you to intervene at the workflow level, if the user has the right authorities. The user can start process instances, or interrupt or resume. It is also possible to change work assignment by transferring an activity from one worklist to another.



46



Business Process Management using MQSeries and Partner Agreement Manager



4.3 Architecture of MQSeries Workflow In the previous section, we looked at MQSeries Workflow as a business modeler and the Buildtime interface and we had a brief look at the MQSeries Workflow Client to run business processes. In this section, we will look at the way an MQSeries Workflow system is organized to make it all happen. When you have a business process that runs through a number of different divisions of your company and each division is in a different location, then how do you build up your MQSeries Workflow environment? What facilities does MQSeries Workflow have to assist you with this?



4.3.1 Runtime architecture MQSeries Workflow is a client/server system with a hierarchical network structure. At the root of the network, MQSeries Workflow has the concept of a domain. An example domain name might be the name of your company. A workflow model is valid for the whole domain: definitions for staff, data structures, programs, IT resources and process templates. At the domain level you can set properties that control the behavior of your MQSeries Workflow installation. These properties are inherited by lower-level concepts, although it is possible to override the values of one or more properties. The next level in the hierarchy is called a system group. All systems within a system group share the same database. If a group has more than one system, you can distribute the workload and continue to have the advantage of shared data. A possible way to name system groups could be a geography or a division. A system is the lowest level in the hierarchy. For example, you can associate a system with a branch or department within your company. In the example shown in Figure 12, the domain is called IBM and has a system group ITSO. The single system in this system group is called RAL01. A system contains all client/server components that you need to run your processes. Depending on your platform, system components can be spread over one or more physical machines. System components that are installed on one physical machine are referred to as a node.
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Figure 12. MQSeries Workflow Network



The system components are designed in a three-tier structure. Tier 1 contains the client components. Clients are responsible for executing the program activities that interact with users. Clients communicate with the servers through the MQSeries Client API or through Common Object Request Broker Architecture Internet InterORB Protocol (CORBA IIOP). The second tier of a system contains the server components that are responsible for managing the execution of processes. The server components can be distributed over several physical machines to achieve load balancing. Communication between the server components is server-to-server MQSeries messaging. Tier 3 is the database server, which holds workflow-relevant data for a system group in your domain. For communication between the server components (tier 2) and the database server, the normal DB2 Client protocol is used. The client components that make up tier 1, are: • MQSeries Workflow Client • Administration Utility • Program Execution Agent The MQSeries Workflow Client is the user interface for managing work items on your worklist and for starting the execution of a process. The MQSeries Workflow Client is based on a set of documented APIs and this makes it possible to write your own MQSeries Workflow Client that more closely fits the needs of your end users. The standard client can contain functionality that you do not want to open to all users, such as process monitoring.
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Figure 13 shows the standard MQSeries Workflow Runtime Client. The top-left window has a list of work items. The top-right pane is a tree view of all lists defined for this user. The bottom pane shows a process monitor, which displays what activities are finished, where the process instance is now, and many other parameters.



Figure 13. MQSeries Workflow Runtime Client



Figure 14 shows the MQSeries Workflow Web Client that is functionally equivalent to the GUI client. It is a servlet/JSP-based solution.



Chapter 4. Basics of MQSeries Workflow



49



Figure 14. MQSeries Workflow Web Client



The Administration Utility is the user interface for an administrator. It communicates with the Administration Server. The utility allows you to stop and start systems or to check the state of a server. The Program Execution Agent invokes application programs and tools that you have defined in the workflow. Applications can run on a different operating system from the one used for the server components. The server components that make up tier 2 are: 1. 2. 3. 4. 5.
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Execution Server Administration Server Scheduling Server Cleanup Server Java CORBA Agent
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Figure 15. MQSeries Workflow components



The Execution Server is responsible for moving the right work item to the right person at the right time. It interprets the process definitions for staff, programs and data. It creates process instances and manages their execution, including stopping and starting. The Execution Server navigates through the workflow and assesses any conditions between individual activities. You can define more than one Execution Server component within a system. Workload is shared between them using a concept called hot pooling. The Administration Server component of a system is responsible for the availability and operation and error recovery of all server components. The Administration Server uses a self-recoverable feature to guarantee the consistency and operation of the system. The Scheduling Server controls all time-related functions of a workflow system. It manages notifications for activities and tracks the due time for
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activities. There can only be one Scheduling Server in an MQSeries Workflow system group. The Cleanup Server is the server component that physically deletes finished process instances. The policy for deleting those instances is set in the Buildtime component. As for the Scheduling Server, only one Cleanup Server is needed for all systems in the system group. Finally, the Java CORBA Agent is the server component that routes client requests from the Java API to the Execution Server and that sends the responses from the Execution Server back to the clients.



4.3.2 Buildtime overview The Buildtime component offers a graphical interface to model your workflow and to define your resources. To make the definitions available to the Runtime, you need to export them in a text-based FDL file. You can also export them in a format that is more friendly for printing. You can also import existing definitions into the Buildtime component. To introduce the definitions into the Runtime environment, you need to import the FDL file. Runtime and Buildtime are loosely coupled for many reasons. First, you could use other modeling tools, such as Holosofx, that are more suitable for your industry. These tools support the same FDL format for import/export purposes. Secondly, the modeling is done on a workstation with other security requirements. The modeler may have no access to the hosts on which the Runtime environment is configured. Finally, because the Buildtime and Runtime component use different databases, you have an easier way to split the development cycle of a model and the production use of a model.



4.3.3 Staff model MQSeries Workflow provides many ways to organize your staff and assign work items to them. 4.3.3.1 Person The person concept is the base element of the MQSeries Workflow staff model and may be defined in Buildtime or directly in Flow Definition Language (FDL). A person is assigned a user ID and various other attributes. In order to manipulate work items, a session must be established with MQSeries Workflow using this user ID. A user does not have to have a session (be logged on) with MQSeries Workflow for staff resolution (work item assignment) to be performed. Navigation and staff resolution occur in real time, regardless of which users
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are logged on at any moment. Users who never establish a session with MQSeries Workflow can be thought of as team worklists, which is a term that is not formally used by MQSeries Workflow, but which represents a very useful construct. The complete specifications for user definition and authorization considerations are contained in the product documentation. For the purposes of this introduction, we are primarily concerned with the work item authority specification for a user. A user must be the owner of a work item in order to start, check out, or check in (and a few other actions) that item. If a user is authorized for work items of others users, he may view work items assigned to (owned by) those users, and may transfer ownership of a work item between himself and any of those users. A team worklist is defined simply as a person (TEAM_A) with no special authorization credentials. All users who are to be authorized for viewing and transferring work items from TEAM_A to themselves will list TEAM_A in the Process: Work item box in the Authorization tab in the Buildtime settings for a person. 4.3.3.2 Role versus team worklist In MQSeries Workflow, the term role is used to designate a job function that may be associated with a person. A person may be a member of zero or more roles. If the process model specifies dynamic staffing for an activity, then during process execution (when an activity becomes instantiated) the process engine will determine which persons satisfy the role/organization/level criteria and create a work item for each of those users. There is a one-to-one relationship between work item and owner. If there are 10 users who satisfy the staffing criteria, then 10 work items will be created. Staff resolution is done only when an activity is instantiated. If additional users are added to a role after staff resolution has occurred, work items will not be created for them. In contrast, consider the designation of a special user ID to perform the same work assignment function that a role is typically used for. In Buildtime, the activity would be targeted for this person instead of a role. Thus, this is how a user ID can behave like a team worklist. During process execution, such an activity instance would result in a single work item being created. Any logged-on user who is authorized for the work items of this team user ID, will be able to view that work item and
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assume/transfer ownership of it in order to work on it. Also, if work item authorization is granted to a user for this team worklist, then, after an activity has gone through staff resolution, that user will immediately be able to view or transfer work items that are currently owned by that team worklist.



4.3.4 API overview There are two fundamentally different ways for MQSeries Workflow Clients to request services from the MQSeries Workflow servers. The first, more traditional way is for the client to call a function or method to request some kind of service. Most often, to request some service, you need to go through a number of function calls to gradually build up a session and provide all the information that the server might need to fulfill your request. This interface, or API, is available in a number of programming languages: C, C++, COBOL, ActiveX, Notes and Java. The second approach is sending an XML message to the server using messaging services. In this case, all information that is needed by the server is sent in a single XML message. It should also be noted that not all functionality that is available through the callable API is available in the XML messaging API. Another way of categorizing the API is its functionality. You can distinguish three types that covers most of the functionality. The first category is a number of APIs that help you handle worklists. It is this type of API that you need to use when you want to develop your own MQSeries Workflow Client to replace the standard interface. A second type of API provides you with functions, or methods, to handle container data. Container data is the data that MQSeries Workflow applications receive from the MQSeries Workflow server when the corresponding activity is executed. The API provides functions to access input and output containers. A third type of API provides the framework that you need for building an administration program. It is this API that is used by the standard Administration Utility. A complete reference of the programming interface is described in the MQSeries Workflow Programming Guide, SH12-6291.
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Chapter 5. Using MQSeries Workflow in the claim processing This chapter details the MQSeries Workflow component of the sample insurance claim application. MQSeries Workflow is used to drive the sample application. It is used to pass requests and retrieve replies via MQSeries to and from back-end applications and databases. It is also used to allocate work items, such as approval of requests, to the appropriate staff members based on decisions in the flow or staff members roles within the organization. You will install the Buildtime and Runtime flow components of the sample application and test each program and step of the flow as a stand-alone application using stubs and drivers, prior to adding any other MQSeries Integrator or Partner Agreement Manager (PAM) components to the application.



5.1 About the sample application The sample application we have created is the Down Under Insurance Company Emergency Customer Call Centre.The workflow component of the application is shown in Figure 16.
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Figure 16. Overview of workflow processing
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Here are the steps in this application: 1. A customer calls the Call Centre and gives his customer ID to a Call Centre operator. 2. This ID is sent to an MQSeries queue, and then to a back-end system, to extract customer name details. 3. The customer details are retrieved from an MQSeries queue. 4. The details are verified as correct. If they are not, the application ends in error. 5. Details on the incident are placed on an MQSeries queue and sent to a back-end system. 6. A claim number is retrieved from an MQSeries queue. This message also contains a flag as to whether approval is required for coverage for addtional services. 7. If approval is required, a work item is sent to the claims manager for processing. 8. The claim is approved, or if not the Call Centre operator is notified and the application ends. 9. The Call Centre operator then takes details of any additional services that are covered. 10.The details of coverage for any additional services are sent to an MQSeries queue and to a back-end system. 11.The confirmation of rental car details is retrieved from an MQSeries queue and communicated to the customer. In this sample application, only the request for a rental car is processed. Other extras, such as lodging, are not implemented.



5.2 Components The MQSeries Workflow component of the sample application uses the following software and hardware: • Hardware: - IBM PC 300PL, Model 6862, Pentium III running at 550 MHz - 384 MB memory - 13.5GB EDIE hard disk • Software: - Windows NT Server (with Service Pack 6a)
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- MQSeries Workflow v3.2 - MQSeries V5.1 (with CSD 5) - IBM C and C++ Compilers, Version 3.6.5 All software was installed according to the product instructions. We will not be detailing the software installation of any of these products. • Programs written for the sample: -



RequestCustomerDetails RetrieveCustomerDetails GetIncidentDetails RetrieveClaimNumber SelectExtras RetrieveExtras



• Programs written as testing stubs and drivers: - LOADQUEUE A complete specification of the used hardware and software can be found in Appendix A, “Hardware and software configuration” on page 445. An overview of the available programs and data files is found in Appendix B, “Sample application setup” on page 447.



5.3 The Buildtime environment We asume that you have created a default MQSeries Workflow configuration. Such a default configuration is named FMC. For details about building a default configuration, please refer to IBM redbook MQSeries Workflow for Beginners, SG24-5848. All of the components of the Buildtime environment are stored in a DB2 database. We have exported all the components of our sample into an FDL file to import into your sample. MQSeries Workflow Definition Language (FDL) files describe the elements that are stored in the Buildtime database in an ASCII format using an export utility. First, you must log on to the MQSeries Workflow Buildtime environment and load the Buildtime definitions into the database, as follows: 1. Select Start --> Programs --> IBM MQSeries Workflow --> MQSeries Workflow Buildtime - FMC. This will bring up the Buildtime logon window (Figure 17).
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Figure 17. MQSeries Workflow Buildtime Login Window



2. Enter the user ID "ADMIN" and password “password”. 3. Click OK. You will see a window similar to Figure 18.



Figure 18. MQSeries Workflow GUI



You may receive a warning message reminding you to change the password of the ADMIN user ID. You can ignore this by clicking OK. This will take you into the Buildtime environment. To load the sample application workflow you need to import it into the Buildtime environment. 1. Click Buildtime --> Import. This will bring up the import window shown in Figure 19.
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Figure 19. Select the FDL file for import into the Buildtime



2. When building our sample, we have stored all the FDL files in the MQSeries Workflow installed FDL directory. a. Select the file named ALL.fdl. This file contains all the elements for the sample with their status set to NEW. b. Select the Overwrite and FDL from MQSeries Workflow Runtime checkboxes. 3. Click OK. You will receive a message advising you that the import has completed successfully (Figure 20).



Figure 20. Successful completion of import to Buildtime



You will also see in the right-hand pane a log of the import, detailing each object name and the status of the import (Figure 21).
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Figure 21. Buildtime import log
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Select the Processes tab (Figure 22). Under Process Models select Insurance Claim --> Customer Call Centre. You will now see the process model for our sample insurance application.



Figure 22. Customer Call Centre process imported



5.4 Workflow components of the sample application The best starting point for modeling your application is staff definition and the definition of data structures.Next you define the business applications that are used. At that point you may need to refer to the data structures that you defined previously.



5.4.1 Staff resources Select the Staff tab to see a list of staff resources that have been imported (Figure 23). You will be using the ADMIN user to run the sample application. However, the roles that have been created are important from the aspect of the process definition. Each work element in the process definition is allocated based on a person’s role within the company. For the purposes of this sample application, you as ADMIN will be fulfilling all roles.
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Figure 23. MQSeries Workflow staff listing after import



5.4.2 Data structures Select the Implementations tab. Select Implementations --> Data Structures The list of data structures (shown in Figure 24) are the workflow containers that carry data from one work item to another. Our programs will access the contents of these containers to retrieve and extract data.



Figure 24. Implementations after import - data structures



The data structures we have defined for the sample application are as follows:
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1. CallCentreLogOn (see Figure 25).



Figure 25. Properties of data structure - CallCentreLogOn



Right-click the CallCentreLogOn data structure and select Properties to see the fields contained in the structure. The CustomerID is the only element in the CallCentreLogOn structure. This will be completed as the first step in the flow. Click OK.
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2. ClaimDetails (Figure 26)



Figure 26. Properties of data structure - ClaimDetails



Right-click the ClaimDetails data structure and select Properties to see the fields contained in the structure. Double-clicking any of the data structure members will show its properties. Claim Details will be a container filled from information entered in the window and is used as an output container. ClaimDetails elements are as follows: -
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CustomerID IncidentType IncidentDate IncidentTime IncidentDescription ThirdPartyInjurySustained ThirdPartyDamageSustained
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3. ClaimReferenceData (Figure 27)



Figure 27. Properties of data structure - ClaimRefenceData



Right-click the ClaimReferenceData data structure and select Properties to see the fields contained in the structure. Double-clicking any of the data structure members will show its properties. ClaimReferenceData will contain data from both back-end systems and from information entered in the window and will be both an input container and an output container. ClaimReferenceData elements are as follows: -



CustomerID ClaimReference ApprovalRequired RentalCarRequired AccommodationRequired TowingRequired AccidentLocation1 AccidentLocation2
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4. CustomerDetails (Figure 28)



Figure 28. Properties of data element - CustomerDetails



Right-click the CustomerDetails data structure and select Properties to see the fields contained in the structure. Double-clicking any of the data structure members will show its properties. CustomerDetails data will be received from back-end systems and will be used as an input container. ClaimDetails elements include the following: -
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CustomerID Surname Name1 Name2 Address1 Address2 City State PostalCode Country
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- PolicyNumber - VehicleDetails 5. RentalCar (Figure 29)



Figure 29. Properties for data structure - RentalCar



Right-click the RentalCar data structure and select Properties to see the fields contained in the structure. Double-clicking any of the data structure members will show its properties. RentalCar data will be received from back-end systems, or more precisely from external partners via back-end systems, and will be used as an input container. RentalCar elements include the following: -



CustomerID ClaimReference CarRegistration CarMake CarModel CarColour RentalCoyReference
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- DeliveryTime



5.4.3 Programs Programs or program definitions, as the name implies, are the programs to be called or started as program activities in the workflow. The program definition also details the names of the input and output data structures that may be required by the program and the environment in which the program will run. Select Programs to drop down a list of all the programs we have defined, as shown in Figure 30.



Figure 30. Implementations after import - programs



First, let’s discuss the icons we have used for the programs. We have attempted to make the programs, or rather something of their function, identifiable by the icon that is used.
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Some decision required by staff Program Action Yes / No box or information only



Obtain information from customer and process it



Figure 31. Icons in program implementation



As shown in Figure 31, all the Yes / No box (the information icon) or decision required (person icon) programs use an MQSeries Workflow-supplied program named fmcsiyes.exe. This program will pop up a message (Figure 32 )that requires you to click either Yes or No to continue. The return values of either yes or no can be evaluated for conditional processing. We will discuss this later, since we will be using this in the Customer Call Centre process model.



Figure 32. MQSeries Workflow supplied program - fmcsiyes.exe



5.4.3.1 ApprovalRequired An example of the usage of fmcsiyes.exe is the ApprovalRequired program definition. Right-click the ApprovalRequired program and select Properties. You will see a window similar to Figure 33.
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Figure 33. Programs: ApprovalRequired - general properties



The General tab shows the name and description of the program. This is also the property where the icon can be set.
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Figure 34. Programs: ApprovalRequired - data properties



Select the Data tab to see the data structures for this program (Figure 34). The fmcsiyes.exe program can access elements of the nominated Input data structure, in this case the ClaimReferenceData. These settings are nominating the structure that is expected to be passed to the program activity. We will explain later how this is achieved. The output structure in this case is the same as the input structure. The fmcsiyes.exe program is not able to fill output container values.
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Figure 35. Programs: ApprovalRequired - program properties



Select the Windows NT tab to see the program run properties (Figure 35). The path and file name is a fully qualified path to the executable. The executable is located in the workflow binaries directory, which is in the path, and so therefore does not require a fully qualified path. The command-line parameters specify the arguments passed to the executable. The values between the “%” refer to data elements from the input container. These will be filled at runtime with the values passed to the program activity in the input data element container. The implementation type is PC EXE, started in the foreground, and it will be run as a visible program. Other program definitions using the fmcsiyes executable are: • DoNotProceed • ErrorReceivingCustomer
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• ExtrasSent • InformCustomer • NotApproved • Proceed • RequestApproval • VerfiyCustomerName 5.4.3.2 GetIncidentDetails An example of a program that will emulate taking information from the customer and passing it to the application is GetIncidentDetails (the telephone icon). Processing for the GetIncidentDetails activity in the diagram consists of the following: 1. Retrieving the data elements from the input container using MQSeries Workflow API. 2. Accepting input from the Call Centre operator via a DOS window. 3. Creating an MQSeries message from the input data using the CustomerID from the workflow container as the correlation identifier. 4. Putting the message in a queue for processing using MQSeries API.
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Figure 36. Programs: GetIncidentDetails - general properties



Right-click the GetIncidentDetails activity and select Properties. The General tab in Figure 36 shows the name and description of the program. This is also the property where the icon can be set.



74



Business Process Management using MQSeries and Partner Agreement Manager



Figure 37. Programs: GetIncidentDetails - data properties



Select the Data tab to see the data structures for this program (Figure 37). The program we have written will access the elements of the input data container CustomerDetails that is passed into the program activity in the workflow using the MQWF API. We will detail later how this is achieved.
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Figure 38. Programs: GetIncidentDetails - program properties



Select the Windows NT tab to see the program Runtime properties (Figure 38). As mentioned earlier in this chapter, we will be running all of our programs from the MQSeries Workflow binaries directory. So, again there is no requirement for a full path name. The name of the executable is GetIncidentDetails.exe. It is running as a PC executable, started in the foreground. It is also running as visible, since window input is required from the Call Centre operator.
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5.4.3.3 RequestCustomerDetails Many program actions run behind the scenes, that is, not visible to the user but passing data back and forth. An example of one of our programs that is running purely as a program action (the program icon) is RequestCustomerDetails. Processing for the RequestCustomerDetails activity consists of the following: 1. Retrieving the data elements from the input container using MQSeries Workflow API. 2. Creating an MQSeries message from the input data using the Customer ID from the workflow container as the correlation ID. 3. Putting the message on a queue for processing using MQSeries API. Right-click RequestCustomerDetails and select Properties. You will see a window similar to Figure 39.
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Figure 39. Programs: RequestCustomerDetails - general properties



The General tab shows the name and description of the program. This is also the property where the icon can be set.
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Figure 40. Programs: RequestCustomerDetails - data properties



Select the Data tab to see the data structures for this program (Figure 40). The program we have written will access the elements of the input data container CallCentreLogOn that is passed into the program activity in the workflow using the MQSeries Workflow API.
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Figure 41. Programs: RequestCustomerDetails - program properties



Select the Windows NT tab to see the program Runtime properties (Figure 41). As mentioned earlier in this chapter, we will be running all of our programs from the MQSeries Workflow binaries directory. So, again there is no requirement for a full path name. The name of the executable is RequestCustomerDetails.exe. It is running as a PC executable, started in the foreground. Since there is no user interaction required, this program will be running as invisible.
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5.4.3.4 RetrieveCustomerDetails Some program actions not only retrieve data from the input data container, but also populate the output data container to be passed on in the workflow. RetrieveCustomerDetails is one such program. This program also runs behind the scenes, that is, not visible to the user but passing data back and forth. Processing for the RetrieveCustomerDetails activity consists of the following: 1. Retrieving the data elements from the input container using MQSeries Workflow API. 2. Getting a message from the reply queue using the CustomerID from the workflow container as the correlation ID using the MQSeries API. 3. Populating the elements of the output workflow container with the contents of the message using the MQSeries Workflow API. Right-click RetrieveCustomerDetails and select Properties. You will see a window similar to Figure 42. The General tab shows the name and description of the program.
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Figure 42. Programs: RetrieveCustomerDetails - general properties



Select the Data tab to see the data structures for this program (Figure 43).
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Figure 43. Programs: RetrieveCustomerDetails - data properties



The program we have written will access the elements of the input data container CallCentreLogOn that is passed into the program activity in the workflow using the MQSeries Workflow API. It will also set the contents of the output data container CustomerDetails using the MQSeries Workflow API.
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Figure 44. Programs: RetrieveCustomerDetails - program properties



Select the Windows NT tab to see the program Runtime properties (Figure 44). The name of the executable is RequestCustomerDetails.exe. It is running as a PC executable, started in the foreground. Since there is no user interaction required, this program will be running as invisible. 5.4.3.5 RetrieveClaimNumber This program not only retrieves data from the input data container, but also populates the output data container to be passed on in the workflow. This program also runs behind the scenes, that is, not visible to the user but passing data back and forth. The values passed to the workflow container by this program will form the basis for future conditional processing.
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Processing for the RetrieveClaimDetails activity consists of the following: 1. Retrieving the data elements from the input container using the MQSeries Workflow API. 2. Getting a message from the reply queue using the CustomerID from the workflow container as the correlation-id using MQSeries API. 3. Populating the elements of the output workflow container with the contents of the message using the MQSeries Workflow API. Right-click RetrieveClaimNumber and select Properties. The General tab shows the name and description of the program (Figure 45).



Figure 45. Programs: RetrieveClaimNumber - general properties
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Figure 46. Programs: RetrieveClaimNumber - data properties



Select the Data tab to see the data structures for this program (Figure 46). This program will access the elements of the input data container CallCentreLogOn that is passed into the program activity in the workflow using the MQSeries Workflow API. It will also set the contents of the output data container ClaimReferenceData using the MQSeries Workflow API. The value of the container elements will determine the next processing in the process model. This will be discussed later.
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Figure 47. Programs: RetrieveClaimNumber - program properties



Select the Windows NT tab to see the program Runtime properties (Figure 47). The name of the executable is RetrieveClaimNumber.exe. It is running as a PC executable, started in the foreground. Since there is no user interaction required, this program will be running as invisible. 5.4.3.6 RetrieveExtras This program not only retrieves data from the input data container, but also populates the output data container to be passed on in the workflow.
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Processing for the RetrieveExtras activity consists of the following: 1. Retrieving the data elements from the input container using the MQSeries Workflow API. 2. Getting a message from the reply queue using the Customer ID from the workflow container as the correlation ID using MQSeries API. 3. Populating the elements of the output workflow container with the contents of the message using MQSeries Workflow API. Right-click RetrieveExtras and select Properties. The General tab shows the name and description of the program (Figure 48).



Figure 48. Programs: RetrieveExtras - general properties
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Figure 49. Programs: RetrieveCustomerDetails - data properties



Select the Data tab to see the data structures for this program (Figure 49). This program will access the elements of the input data container CallCentreLogOn that is passed into the program activity in the workflow using the MQSeries Workflow API. It will also set the contents of the output data container RentalCar using the MQSeries Workflow API.
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Figure 50. Programs: RetrieveExtras - program properties



Select the Windows NT tab to see the program Runtime properties (Figure 50). The name of the executable is RetrieveExtras.exe. It is running as a PC executable, started in the foreground. Since there is no user interaction required, this program will be running as invisible. 5.4.3.7 SelectExtras This program sends the details of the policy extras cover to the back-end application. The Call Centre operator is required to answer questions on the DOS window for sending in the message.
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Processing for the SelectExtras activity consists of the following: 1. Retrieving the data elements from the input container using the MQSeries Workflow API. 2. Asking questions and receive responses from the Call Centre operator. 3. Formatting the responses into a message using the Customer ID of the input container as the correlation ID. 4. Putting the message on a queue for transmission to a back-end system using the MQSeries API. Right-click SelectExtras and select Properties. The General tab shows the name and description of the program (Figure 51).



Figure 51. Programs: SelectExtras - general properties
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Figure 52. Programs: SelectExtras - data properties



Select the Data tab to see the data structures for this program (Figure 52). This program will access the elements of the input data container ClaimReferenceData that is passed into the program activity in the workflow using the MQSeries Workflow API. It does not set any output container values.
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Figure 53. Programs: SelectExtras - program properties



Select the Windows NT tab to see the program Runtime properties (Figure 53). The name of the executable is SelectExtras.exe. It is running as a PC executable, started in the foreground. Since there is user interaction required in the form of request and response, this program will be running as visible.



5.4.4 Process definition To view the business process definition, in the Buildtime environment, select the Processes tab. Click Insurance Claim --> Customer Call Centre. Right-click Customer Call Centre and select diagram.
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Our business process consists of many activities. The business process diagram shown in Figure 54 specifies the control flow, the data flow, conditions for processing and the application programs to be run for each activity.



Source node activity



Figure 54. Customer Call Centre business process diagram



Again, we have defined the program activities using icons that indicate something of the nature of the processing involved in the program activity. The icon legend is as follows:
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Person



Requires a response or action by a staff member.



Disks



Information or processing from back-end or other system.



Information



Pop-up box for information purposes.



Telephone



Information required from customer.



Cog



Possible long processing (for example rental car details may be obtained from the rental car company by phone or fax).
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The other icon that is marked with an arrow in the diagram is that of a source node activity. The source node is an input container that contains data to be passed to the process. As we will show later, when a process instance is started, the initiator of the process will be prompted to enter the values to fill the source container. To view the properties of the process model itself, right-click Customer Call Centre and select Properties. You will see a window similar to Figure 55.



Figure 55. Process: Customer Call Centre - general properties



The general properties of the process give a name, description and icon to the process model. The category attribute of a process model can be used to group process instances for authorization purposes. As the ADMIN user has authorization for all categories, we have added this for information purposes only. We also do not require validity time or date stamps.
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Figure 56. Process: Customer Call Centre - data properties



Select the Data tab for data structure properties (Figure 56). The input data container is the CallCentreLogOn structure. Selecting Force prompt for data at process start specifies that the initiator of the process is prompted for data which initializes the input data structure. In our case, this means that the process initiator, the Call Centre operator, is prompted to enter the value of Customer ID for the CallCentreLogOn data structure.The output data structure indicates that the values in CallCentreLogOn will be passed as output to the source node that we mentioned earlier. 5.4.4.1 Program activities - general properties Right-click the RequestCustomerDetails program activity and select Properties. You will see a window similar to Figure 57.
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Flashlight icon



Name of the executable



Figure 57. Program activity: RequestCustomerDetails - general



Select the General tab. General properties of a program activity are the name of the program activity and the icon used to represent it (pointed to in Figure 57), and the program definition associated with this activity. You can change the icon representation in the diagram by clicking on the flashlight icon. MQSeries Workflow includes a lot of icons that can help you to make the process diagram easier to understand. 5.4.4.2 Program activities - start conditions Select the Start tab. The start properties specify how the program activity is to be started and the start conditions (Figure 58).
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Figure 58. Program activity: Request Customer Details - start conditions



The start properties here specify that the program activity is to be started automatically in Runtime when the start condition is met. The start condition here specifies that at least one transition condition for the incoming connector must be true for the start condition to have been met. In this case there are no transition conditions, since this is the first program activity in the process. We will describe where transition conditions are used in a later program activity. 5.4.4.3 Program activities - exit properties Select the Exit tab. The exit properties specify how the program activity is to end and the exit conditions (Figure 59).
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Figure 59. Program activity: Request Customer Details - exit conditions



The exit properties here specify that the program activity is to be exited automatically, that is, when the exit activity evaluates to true, or as soon as the activity finishes if no exit condition is specified. The exit condition here specifies that the exit condition evaluates to true if the return code equals zero. 5.4.4.4 Program activities - data properties Select the Data tab. The data properties specify the input and output data containers (Figure 60).
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Figure 60. Program activity: Request Customer Details - data properties



For this program, the input container is the CallCentreLogOn and the output container is also the CallCentreLogOn. The values of the input and output structure in the program activity match the data structures in the program definition data properties. 5.4.4.5 Program activities - staff Select the Staff1 tab (Figure 61). The staff properties specify to which staff member’s worklist the item will be sent.
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Who will receive the work item



Figure 61. Program activity: Request Customer Details - staff properties



For this program activity, the staff member who started the process will receive the work item. 5.4.4.6 Program activities - conditional control connectors The control connectors define the potential flow of control between program activities. The actual flow is determined at runtime by the evaluation of transition conditions. To see the transition condition on a connector, right-click the control connector, which is the unbroken line.
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Figure 62. Control connector - transition based on program return code



The example in Figure 62 shows the transition condition between the RetrieveCustomerDetails program activity and the ErrorReceivingCustomer program activity. The transition condition specifies that if the return code from RetrieveCustomerDetails is not zero, then the condition evaluates to true and the ErrorReceiving Customer program activity is executed.
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Conditional branch based on YES or NO response



Conditional branch based on program return code Figure 63. Control connector - transition based on operator response



This example in Figure 63 shows the difference between any non-zero return code or a specific return code such as one returned by a yes or no response from the program fmcsiyes.exe. A yes response in this case will cause _RC=1 to evaluate to true. The transition from VerifyCustomerDetails to GetIncidentDetails requires that the Call Centre operator reply yes to the verification question.
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Figure 64. Control connector - transition based on output container element value



The transition from RetrieveClaimNumber to SelectExtras relies on the values in the output container set by the RetrieveClaimNumber program. The container element ApprovalRequired will contain a value that is evaluated by the control connector. If the value is N (as shown in Figure 64) meaning no approval required, the RequestExtraServices condition evaluates to true and control is passed directly to SelectExtras.
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Work item for Claim Manager



Conditional start based on value of ‘Approval Required’



Figure 65. Process: Customer Call Centre - conditional processing



Conversely, if the value in the workflow container element is Y (yes, approval required) the transition condition “ApprovalRequired” evaluates to true and so control passes from RetrieveClaimNumber to ApprovalRequired. The transition condition following ApprovalRequired, when evaluated to true (that is, return code equals one, a yes response from fmcsiyes.exe), will then pass control to SelectExtras. Note also the Staff1 properties of the Approval program activity.
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Approval by Claims Manager



Figure 66. Program execution based on role



As opposed to all other work items that go to the worklist of the process starter (the Call Centre operator), the work item for approval will be pushed to the list of the staff member designated as the coordinator of the role of Claims Manager (that is, who has been designated as Claims Manager). In Figure 66, this is the ADMIN user again.



5.5 The Runtime environment MQSeries Workflow Buildtime provides the interface to define the business process models and store them in a database. The Runtime environment provides the environment to start and execute processes and perform work distribution. The Runtime environment uses a different database; consequently the definitions from the Buildtime environment must be imported into the Runtime database using an FDL file export.



106



Business Process Management using MQSeries and Partner Agreement Manager



5.5.1 Importing Buildtime definitions into Runtime When building our sample, we have stored all the FDL files in the MQSeries Workflow installed FDL directory. The FDL file for import to Runtime is named ALLforRuntime.fdl. The import utility for workflow Runtime is fmcibie . To import the definitions to the Runtime environment, do the following: 1. Open a DOS window. 2. Change directory (cd) to the directory where you have stored the Runtime FDL file. 3. Type in the MQSeries Workflow import command (as shown below) for fmcibie using the following options: -u



ADMIN (user ID)



-p



password (password)



-o



(overwrite existing)



-t



(verify and translate process models)



-i



LLforRuntime.fdl (input FDL file)



C:\>e: E:\>cd fmcwinnt E:\fmcwinnt>cd fdl E:\fmcwinnt\FDL>dir *.fdl Volume in drive E is Data Volume Serial Number is C451-F15E Directory of E:\fmcwinnt\FDL 04/01/01 22/12/00 13/06/00 13/06/00 13/06/00



10:13 11:17 21:04 21:04 21:04 5 File(s)



10,543 ALL.fdl 24,785 ALLforRuntime.fdl 1,595 fmcins32.fdl 7,857 fmcirf23.fdl 7,299 fmcirf32.fdl 52,079 bytes 5,625,651,200 bytes free



E:\fmcwinnt\FDL>fmcibie -u ADMIN -p password -o -t -i ALLforRuntime.fdl
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. . FMC26500I FMC21500I FMC21510I FMC26510I



Start translate process 'Customer Call Centre'. Begin verification of process Customer Call Centre. End verification of process Customer Call Centre (0 errors, 0 warnings). Finished translating process 'Customer Call Centre'.



You are now ready to log on to the MQSeries Workflow Runtime environment.



5.5.2 Setting up the Runtime session The MQSeries Workflow Client is the Runtime front-end graphical user interface. Select Start --> Programs --> IBM MQSeries Workflow --> MQSeries Workflow Client - FMC. This will bring up the logon window (Figure 67).



Figure 67. Logging on MQSeries Workflow Runtime



Enter ADMIN as the user ID,and password as the password. FMCSYS is the system name, or your system name if you configured MQSeries Workflow to use a different system name. FMCGRP is the group name, or your system name if you configured MQSeries Workflow to use a different system name. Click OK.
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Figure 68. MQSeries Workflow Client



5.5.2.1 Create a worklist 1. In the window shown in Figure 68, right-click the Worklists folder and select Create New Worklist. This will bring up the Create new worklist window. 2. Select the General tab: a. Enter the name Insurance for this worklist. b. Select the Private radio button for list type, which means that only ADMIN can access this list. c. Select the Push checkbox, which will ensure that the work items are refreshed automatically.
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Figure 69. Create new Worklist - General



3. Select the Filter tab: a. Click Add, to bring up the filter criteria window. b. Select Owner in the Field selection. c. Select Equal in the Operator selection. d. Type “ADMIN” in the Value selection. Make sure you use the double quotes around the user ID. This selection will ensure that only work items for user “ADMIN” appear in the worklist.
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Figure 70. Add a filter for your worklist



4. Click OK.



Figure 71. Create new Worklist : adding a filter



5.5.2.2 Create a process instance list 1. Right-click the Process Instance Lists folder and select Create New Process Instance List. This will bring up the Create new process instance window.
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2. Select the General tab: a. Enter the name Insurance for this process instance. b. Select the Private radio button for list type.



Figure 72. Create new Process Instance List - General



3. Click OK. 5.5.2.3 Create a process template list 1. Right-click the Process Template Lists folder and select Create New Process Template List. This will bring up the Create new process template window. 2. Select the General tab: a. Enter the name Insurance for this process template list. b. Select the Private radio button for list type. c. Click OK.
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Figure 73. Create new Process Template List



Arrange the windows by selecting Window --> Tile Vertically. See Figure 74.



Chapter 5. Using MQSeries Workflow in the claim processing



113



Figure 74. Workflow Runtime Client window



When the process model is translated and imported into the Runtime database, a Runtime process template is created. Each process template is stored in the Runtime database in the Runtime format. A process instance is a running copy of a process template. Many instances of the same process template may be instantiated and run concurrently, independently of each other. You are now ready to test the workflow by starting an instance of the Insurance Demo process template.
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5.6 Stand-alone test Initially, you will need to test the MQSeries Workflow component as a stand-alone application. We do not currently have any back-end systems or applications to feed the response data to the workflow queues. For this first set of tests, you will use some simple test programs that load the response messages onto the queues to simulate the activities of the back-end systems and external vendors. In our application, the workflow application accesses the following MQSeries queues: • REQUEST.CUSTOMER.DETAILS • REQUEST.CLAIM.NUMBER • REQUEST.EXTRAS.DETAILS • REPLY.CUSTOMER.DETAILS • REPLY.CLAIM.NUMBER • REPLY.EXTRAS.DETAILS Our Customer Call Centre application queue manager is named M23CAAXY. Create a queue manager for your workflow application. We have used an MQSeries cluster, since our final application spans three servers. However, for initial testing a single queue manager is sufficient. Define each of these queues to your queue manager. Our sample application also writes to a log file for tracking and debugging purposes. This log is located in c:\InsuranceClaimDemo.Log. We suggest running a ‘tail’ utility on this log in a DOS window for testing purposes. Our fictitious customer for this test has customer ID of GAVIN12345. Our test program LOADQUEUE runs as follows: LOADQUEUE queueName qmgrName correlid < dummy msg file



The correlid parameter should be a customer ID, like GAVIN12345. To load application reply queues, do the following: 1. Open a command window. 2. Change directory (cd) to your test executable directory. 3. Ensure that the following text files are in this directory.
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- CustomerDetails.txt - ClaimNumber.txt - RentalReply.txt 4. To simulate a response from a back-end system, PUT a message on to the REPLY.CUSTOMER.DETAILS queue with a correlid of GAVIN12345 as follows: LOADQUEUE REPLY.CUSTOMER.DETAILS M23CAAXY GAVIN12345 < customerdetails.txt



5. To simulate a response from a back-end system, PUT a message on to the REPLY.CLAIM.NUMBER queue with a correlid of GAVIN12345 as follows: LOADQUEUE REPLY.CLAIM.NUMBER M23CAAXY GAVIN12345 < claimnumber.txt



6. To simulate a response from a back-end system or business partner - PUT a message on to the REPLY.EXTRAS.DETAILS queue with a correlid of GAVIN12345 as follows: LOADQUEUE REPLY.CLAIM.NUMBER M23CAAXY GAVIN12345 < rentalreply.txt



We are now ready to run a test of the workflow. Log on to the MQSeries Workflow Client as the ADMIN user as shown previously. Right-click the Customer Call Centre process template. Select Create and start instance. You will now see Figure 75.
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Figure 75. Input data structure - CallCentreLogOn



In the value box, type in our fictitious customer ID GAVIN12345. Click OK to start the workflow. The message window for VerifyCustomerDetails, shown in Figure 76, will appear after the message has been retrieved from the REPLY.CUSTOMER.DETAILS queue.



Figure 76. Verify customer details



Click Yes to continue. The DOS window for GetIncidentDetails will appear as shown in Figure 77.
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Figure 77. GetIncidentDetails entry window



Enter the details of the incident as above. Note: Do not use spaces in the description field. After the claim number message is retrieved from the REPLY.CLAIM.NUMBER queue, the ApprovalRequired message window will appear (Figure 78).



Figure 78. Claim approval required



Select Yes to continue. The Approval message window shown in Figure 79 will appear. Select Yes to continue.
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Figure 79. Approval program activity



This will now take you through to the SelectExtras program activity Enter the data on the SelectExtras DOS window as shown in Figure 80. Note: again, do not use spaces in any of the text fields.



Figure 80. SelectExtras entry window



You will then receive a message notifying you that your details have been sent for processing. Select Yes to continue.



Figure 81. ExtrasSent
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This message window is the one that appears as the cog icon on the process model diagram. In the real world this may take some time. For the RetrieveExtras program, we have coded an MQGET with the wait option. When the message has been retrieved from the REPLY.EXTRAS.DETAILS queue, the final window will appear (Figure 82).



Figure 82. InformCustomer



Select Yes to end the workflow (and the test). A sample of the application log from the test is shown below.



===> Customer Call Centre - Start of Retrieve Rental Details Customer Call Centre - End of Retrieve Rental Details claim limit - 'Y', 'N'*/ charApprovalReceived[1];/* approval has been received- 'Y', 'N'*/
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charRentalCarRequired[1];/* rental car required? - 'Y', 'N'*/ charAccommodationRequired[1];/* accommodation required?- 'Y', 'N'*/ charTowingRequired[1];/* towing required for own car? - 'Y', 'N'*/ charAccidentLocation1[25];/* address at which rental car needed*/ charAccidentLocation2[25];/* address at which rental car needed*/ } ExtraServicesRequest; } EXTRAS_REQUEST;



Figure 100. EXTRAS_REQUEST input message format



The output format for the BPM_Request_Extra_Services message flow is found in ExtraServicesApproval.h, as follows: typedef struct EXTRAS_APPROVAL { struct { charCustomerID[10]; charPolicyNumber[12]; charClaimNumber[3];/* PolicyNumber & ClaimNumber identifies the claim*/ charRentalCarStatus[1];/* rental car approval state - 'Y','N','R'eqd*/ charAccommodationStatus[1];/* accommodation approval state?'Y','N','R'eqd*/ charTowingStatus[1];/* towing approval state? - 'Y','N','R'eqd*/ charRepairerStatus[1];/* repair approval state? - 'Y','N','R'eqd*/ charAssessorStatus[1];/* assessment approval state? - 'Y','N','R'eqd*/ charAccidentLocation1[25];/* address at which rental car needed*/
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charAccidentLocation2[25];/* address at which rental car needed*/char RentalCarID[10];/* rental car company CustomerID*/ charRentalCarID[10];/* rental car company CustomerID*/ charAccommodationID[10];/* accommodation provider CustomerID*/ charTowingID[10];/* towing company CustomerID*/ charRepairerID[10];/* auto repairer or builder CustomerID*/ charAssessorID[10];/* assessor CustomerID*/ } ExtraServicesApproval; } EXTRAS_APPROVAL;



Figure 101. EXTRAS_APPROVAL_REQUEST output format



6.4.1 ExtraServicesDetails Compute node The ExtraServicesDetails Compute node is the most complex single node in the BPM application.
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Figure 102. ExtraServicesDetails Compute node, window 1



Figure 102 contains nothing more than message property and format initialization and declaration of variables used elsewhere in the ESQL. The debug and trace mechanism is discussed in detail in 6.6, “Trace methodology for use with MQSI Compute nodes” on page 154.
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Figure 103. ExtraServicesDetails Compute node, window 2



The top box in Figure 103 above contains statements to initialize working variables. The middle box in Figure 103 is simply copying fields from the input message to the output message. The bottom box SETs approval status codes in the output message depending on the contents of the corresponding input service-required flags. The accident location fields are also transferred from input to output.
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Figure 104. ExtraServicesDetails Compute node, window 3



The top box in Figure 104 SETs the value of the LOCATION variable to a wildcard format acceptable to the SQL LIKE clause of the SELECT statement. This facilitates selection of service providers specific to a locality. This selection is possible through correctly setting the CUS_VALID_AREAS column of the BPM_CUSTOMER table. In the present version of this application, the AddressLocation2 input message field must contain any string that can be found in this column in a row of the BPM_CUSTOMER table for the relevant supplier’s CUSTOMER_TYPE. The middle box illustrates the use of the LOCATION wildcard value to select a rental car supplier for this claim. The same method is repeated for the accommodations supplier and the towing supplier. The bottom box in Figure 104 shows the IF statement that determines whether the remaining status flags to be set relate to a vehicle claim or to a building. The remainder of this IF statement appear in Figure 105.
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Figure 105. ExtraServicesDetails Compute node, window 4



Chapter 6. Using MQSeries Integrator in the claim processing



147



Figure 106. ExtraServicesDetails Compute node, window 5



Figure 106 shows the final window for the ExtraServicesDetails Compute node. The top box shows the SETting of the five output Supplier Id numbers that have been determined in the previous two windows for this Compute node. Finally, the bottom box in Figure 106 contains the SQL UPDATE statement that will update the BPM_CLAIM table with these values and with the Address details that were also input to this node.
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6.5 BPM_Extra_Services_Approval message flow The message flow BPM_Extra_Services_Approval (Figure 107) receives its input from Partner Agreement Manager via the REPLY.EXTRAS.APPROVAL queue.



Figure 107. BPM_Extra_Services_Approval message flow



The input message format, EXTRAS_APPROVAL_REPLY contains updated approval status flags, indicating which have been approved by the corresponding external suppliers. A future implementation could allow an iterative interaction with Partner Agreement Manager such that Extra Services could be requested from alternate suppliers where those services
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have been declined. The C header file for the input format is in ExtrasApprovalReply.h: typedef struct EXTRAS_APPROVAL_REPLY { struct { charCustomerID[10] ; charPolicyNumber[12] ; charClaimNumber[3] ;/* PolicyNumber & ClaimNumber identifies the claim */ charRentalCarStatus[1] ;/* rental car approval state- 'Y','N','R'eqd*/ charAccommodationStatus[1] ;/* accommodation approval state ? -'Y','N','R'eqd*/ charTowingStatus[1] ;/* towing approval state ?- 'Y','N','R'eqd*/ charRepairerStatus[1] ;/* repair approval state ?- 'Y','N','R'eqd*/ charAssessorStatus[1] ;/* assessment approval ?- 'Y','N','R'eqd*/ charRentalCarID[10] ;/* rental car company CustomerID*/ charAccommodationID[10] ;/* accommodation provider CustomerID*/ charTowingID[10] ;/* towing company CustomerID */ charRepairerID[10] ;/* auto repairer or builder CustomerID*/ charAssessorID[10] ;/* assessor CustomerID */ } ExtrasApprovalReply ; } EXTRAS_APPROVAL_REPLY ;
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Figure 108. EXTRAS_APPROVAL_REPLY input message format



Output from this message flow is an EXTRAS_REPLY message is sent to MQWF via queue REPLY.EXTRAS.REQUEST. typedef struct EXTRAS_REPLY { struct { charCustomerID[10] ; charPolicyNumber[12] ; charClaimNumber[3] ;/* PolicyNumber & ClaimNumber identifies the claim */ charRentalCarID[10] ;/* rental car company CustomerID*/ charAccommodationID[10] ;/* accommodation provider CustomerID*/
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charTowingID[10] ;/* towing company CustomerID */ charRepairerID[10] ;/* auto repairer or builder CustomerID*/ charAssessorID[10] ;/* assessor CustomerID */ } ExtraServicesReply ; } EXTRAS_REPLY ;



Figure 109. EXTRAS_REPLY output message format
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6.5.1 ProcessExtrasApproval Compute node The ProcessExtrasApproval Compute node is very straightforward. It simply copies the fields as shown from the input message to the output message. The approval status flags are not required in the reply message, only the supplier ID numbers.



Figure 110. ProcessExtrasApproval Compute node
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6.6 Trace methodology for use with MQSI Compute nodes While working on the MQSI portion of this sample application, we found a need for a more granular trace mechanism, particularly for use with Compute nodes. This should be seen as a complementary tool to the Trace node, and certainly not a replacement for it. With MQSeries Integrator V2.0.1, there are no easy ways to debug complex and lengthy Compute nodes. A Trace node before of after a Compute node may not be sufficient to help you during the debugging phase.



6.6.1 DB2 trace table The heart of this trace methodology is a simple DB2 table, BPM_TRACE. The SQL statement to create this table is shown in Figure 83 on page 125 and is also repeated below for convenience. Note the use of NOT NULL WITH DEFAULT on the TRA_TIME column. This means that every new trace row inserted will have this column set to the CURRENT_TIME value. CREATE TABLE BPM_TRACE ( TRA_TIME TIMESTAMP NOT NULL WITH DEFAULT PRIMARY KEY, TRA_NAME CHAR(30), TRA_DESC VARCHAR(80)) IN BPM



The BPM_TRACE table is initialized with the SQL INSERT statement. This initial row (let’s call it the status row) is also updated as required and always contains the current trace status. INSERT INTO BPM.BPM_TRACE (TRA_TIME,TRA_NAME,TRA_DESC) VALUES ('1900-01-01-00.00.00.000000', 'Trace', 'Inactive');



6.6.2 Starting and Stopping the trace or changing the trace status Tracing is started using the following SQL statements. There is an UPDATE statement to change the TRA_DESC column in the status row to Active. The INSERT statement will insert a new row into the trace table with the CURRENT_TIME to indicate the time at which tracing was activated. update BPM.BPM_TRACE set TRA_DESC = 'Active' where TRA_TIME = '1900-01-01-00.00.00.000000'; INSERT INTO BPM.BPM_TRACE (TRA_NAME,TRA_DESC) VALUES ('Trace', 'Active');



Similarly, tracing is stopped by executing the following SQL script: update BPM.BPM_TRACE
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set TRA_DESC = 'Inactive' where TRA_TIME = '1900-01-01-00.00.00.000000'; INSERT INTO BPM.BPM_TRACE (TRA_NAME,TRA_DESC) VALUES ('Trace', 'Inactive');



A third trace status, called Commit, is also necessary in some cases. This is because, in certain error situations, MQSI will roll back all activity in a message flow. When this happens, any DB2 updates to the BPM_TRACE table will also be rolled back. Note that when tracing is in Commit mode, it will not only cause trace information to be committed, but also any application database activity. So, be wary in the use of Commit tracing and only do so in a test environment. update BPM.BPM_TRACE set TRA_DESC = 'Commit' where TRA_TIME = '1900-01-01-00.00.00.000000'; INSERT INTO BPM.BPM_TRACE (TRA_NAME,TRA_DESC) VALUES ('Trace', 'Commit');



6.6.3 Tracing a Compute node The SET DEBUG statement in Figure 111 uses a SELECT SQL statement to determine the current tracing status. The following IF statement allows conditional execution of the trace statements. This can be repeated at any suitable point in the Compute node ESQL to enable tracing in as granular a fashion as you require.



Figure 111. Illustrating the use of tracing in the Compute node



Note the second IF statement in Figure 111. This relates to Commit mode tracing, as described above.
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Part 3. Extending the BPM solution to a B2B solution In the previous parts of this redbook, we have built the basis for the integration of a number of IT systems. Databases and applications are all hooked up together. MQSeries Workflow makes sure that the business processes are respected and executed in the way that the business analyst has specified. MQSeries Integrator has the responsibility to deliver information in the correct format at the correct destination. Now, we want to extend this Enterprise Application Integration (EAI) solution to external partners. To integrate the business process with the external world, we introduce the product WebSphere Business Integrator Partner Agreement Manager into the solution. Chapter 7, “Basics of Partner Agreement Manager” on page 159 starts with an introduction to this product. It explains the basic concepts and architecture of the product and it positions this product in the BtoB marketplace. Chapter 8, “Installing and Configuring Partner Agreement Manager” on page 167 provides detailed steps on how to install and configure this product. Chapter 9, “Connecting to external enterprises with PAM” on page 269 details the configuration to link up the insurance company with the car rental company. Chapter 10, “Stepping through the complete application” on page 381 steps through the whole application from an end-user perspective. At each step, we explain what happens, where the business process is taken to, and what information is flowing from where to where.
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Chapter 7. Basics of Partner Agreement Manager In this chapter, we would like to introduce Partner Agreement Manager (PAM) and describe the market in which it operates. Where does PAM fit in the IBM world of MQSeries and WebSphere? We describe the major components of the PAM product and the other offerings.



7.1 Positioning Partner Agreement Manager Back in 2000, IBM had a reseller agreement for Extricity’s AllianceManager product set. In September 2000, IBM announced it had licensed the technology of Extricity to integrate it in the upcoming WebSphere Business-to-Business Integrator product. The product WebSphere Business-to-Business Integrator Partner Agreement Manager has been available since December 2000. IBM has others partnerships in the B2B space. At first there appears to be a conflict with the Ariba-i2 coalition. However, the partnership with Extricity complements the partnership with i2 and Ariba. The Ariba product set can be considered as an end-user application that focuses on the so-called MRO (maintenance, repair, operations) aspect of B2B. Ariba manages the procurement of MRO services. The Partner Agreement Manager product is an automated platform for B2B that has a much broader range of B2B functions. The technology of i2 is focused on advanced algorithms for planning and scheduling production processes. This is again a subset of what you typically find in the characterization of B2B applications. i2 and Ariba provide B2B application services, while Extricity provides B2B infrastructure software that can be used as the foundation for any type of B2B application. To assist in the development of your B2B application, you can also use the ProcessPaks of Extricity. The combination of MQSeries and WebSphere is also often used in a B2B environment as well. MQSeries products have been successfully deployed beyond the four walls of the enterprise. With the recent addition of MQSeries Internet Pass-thru, you can run MQSeries communication over the Internet without impacting security. But, in general, the tools that you need to manage a multi-partner relationship are different from tools needed for application integration. After all, application-to-application (A2A) is not the same as business-to-business (B2B).
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A number of variables play a role in the positioning of MQSeries versus PAM: 1. Variety of platforms When a large number of different platforms are involved, MQSeries does a better job because it is available on so many platforms. 2. Complex or simple internal transformation The message transformation function of MQSeries Integrator is large. PAM offers some transformation, too, but that is not always sufficient. 3. Stateless / process MQSeries messaging is very well suited in stateless operations. However, when transactions last hours or days, it becomes difficult to use MQSeries. Partner Agreement Manager has the knowledge to manage long-lasting transactions. 4. Number of partners MQSeries for B2B integration is probably sufficient as long as the number of partners is limited. PAM offers more functionality to handle large numbers of partners. 5. Availability of MQSeries Of course, when MQSeries is available for all partners, you will probably prefer to use the existing knowledge. Although MQSeries is widely used today, it’s still not available everywhere. 6. Static or dynamic partners If your partners change often, then MQSeries messaging can become more difficult to manage than a PAM environment. 7. Centralized versus distributed control In an MQSeries environment, control needs to be more centralized. However, in a typical B2B environment, control will be distributed. Here, Partner Agreement Manager fits better because of its built-in control and mutual acceptance procedures. Looking at the above points, then you will probably see that for your internal communications, most points lead to MQSeries. While for communication with your partners, a specialized product like Partner Agreement Manager is more suitable. WebSphere Application Server can act as a frontend for browser-based business-to-business interactions.
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7.2 Components of Partner Agreement Manager WebSphere Business-to-Business Integrator Partner Agreement Manager consists of four major components: 1. Process Engine, which is the core of the product - A unified platform for managing all B2B interactions - Defines and manages channels, adapters, internal/external process design and execution, security 2. Partner Channels, which represent the external communication - PAM channel - Partner Agreement View for browser-based access 3. Integration Adapters, which makes it possible to integrate back-end applications - MQSeries adapter for MQSeries, MQSeries Integrator, and MQSeries Workflow - Utility adapter for file oriented solutions 4. A common management framework that supports the management of all major functions and system information.
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7.2.1 Process Engine The Process Engine is the kernel of the Partner Agreement Manager product. It is responsible for controlling the execution of processes running in the server. The Process Engine runs two types of process: external or public processes and internal or private processes. Public processes govern interactions that cross organizational boundaries. Public processes specify a set of interdependent exchanges of messages. These processes can involve arbitrary numbers of partners and process logic can include simple sequencing of steps, multi-path disjunctive and conjunctive branches, and loops. The public process can represent custom processes created by a PAM user or imported standards-based processes such as RosettaNet PIP. Private processes govern interactions that are local to an organization that uses PAM. Private processes specify a set of dependent actions of various types including calls to application systems via adapters, data transformation, e-mail notifications, subprocess calls, script block executions, and user approval steps. Private process logic can include branching, conjunctive and
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disjunctive, and loops. Private processes are the means by which a PAM implementation executes its associated steps in a public process. The public/private process separation provides several advantages, the most important being the ability to manage change. Local changes to information systems or information flow can be isolated in private processes and can be changed independently. The Process Engine keeps track of running processes or those that are waiting for input. A process can be started at regular intervals or as a response to system events, such as the arrival of messages in an MQSeries queue.



7.2.2 Channels and Channel Manager Channels are the mechanism by which PAM manages the multiplicity of external communication requirements. Enterprises may, for example, communicate with some partners via EDI, others use a standard communication mechanism like RosettaNet, and still others use combinations of standards-based communication and ad-hoc agreement mechanisms. In the overall architecture of PAM, channels isolate communication details such as network protocol and security agreements from the other components. Each channel represents a particular method of communication and is capable of controlling bi-directional communications with a set of partners of external organizations. A wide variety of pre-built channels are available for Partner Agreement Manager. A software development kit is available to assist in the creation of new channel types. A Channel Manager manages and provides services to a set of channels. Key functions include management of channel install/uninstall, start/stop, checkpointing and logging. The Channel Manager is the external communication interface to the Process Engine.



7.2.3 Adapters and Adapter Manager Adapters act as the bridge between the Process Engine and the internal business applications. Each adapter exposes a specific set of application functionality in two ways: • Through events that stream into the Process Engine and that can be used for process initiation. • Through operations that can be invoked by the running processes.
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Adapters, then, are responsible for mapping these operations and events to either native interfaces supported by the application or appropriate middleware layer that provides connectivity to the application. An Adapter Manager manages and provides services to a set of adapters. Key functions include adapter install/uninstall, start/stop and checkpointing/logging. The Adapter Manager is the internal communications interface to the Process Engine.



7.2.4 Common Management Framework The Partner Agreement Manager product is built on a common management framework to simplify control of the individual components, information, and behavior. Access to management functionality is provided through the PAM client and through programmatic APIs. The framework includes: 1. Channel Management Partner Agreement Manager provides facilities for the installation, property and state management of channels. Individual channels can provide their management functions for configuration and other purposes. 2. Adapter Management Partner Agreement Manager provides facilities for the installation, property and state management of adapters. Individual adapters can provide their management functions for configuration and other purposes. 3. Partner Management Partner Agreement Manager maintains a profile for every partner in a business process, including security information such as certificates that needs to be exchanged with the partners in a process. Communication information, such as host and port information, also needs to be configured for each partner. 4. Process definition and business object definition Partner Agreement Manager provides an interface for the definition of both public and private processes. Business objects describe the type of information that is exchanged. The management of these objects includes change and version control. 5. User management Partner Agreement Manager provides standard user management and access control. For example, there is a distinction between a process designer and a process controller.
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7.3 PAM, PAC, PAV, ProcessPaks, and more Partner Agreement Manager is the not the only product in the portfolio of IBM and Extricity. In the previous sections of this chapter, we’ve been focusing on the Partner Agreement Manager. PAM provides the full functionality that we’ve described before. Partner Agreement Connect (PAC) allows you to connect to existing Partner Agreement Manager installations. However, with PAC, you cannot edit public processes. Thus, a PAC license is not sufficient to create and define connections to your suppliers. You can only take part of the public process that has been defined for you by someone else. While PAC already provides a lower entry point for your partners, Partner Agreement View (PAV) should remove any technical problems for your partners to connect and interact with you. With PAV, it is possible to generate Web pages that interact with the existing PAM server. Your partners can use a browser to connect to your Web server that hosts PAM and can collaborate with you. An Internet connection is all they need to exploit inter-enterprise process collaboration. ProcessPaks offer another way to reduce the implementation time. This offering consists of a number of public processes that are standard in a specific industry or that consist of public processes based on best practices in an industry.
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Chapter 8. Installing and Configuring Partner Agreement Manager This chapter will take us through the step-by-step instructions to configure and install PAM. You will install the product (with the appropriate prerequisite software) and both the administrative components and partner definition components. Once you have completed this on both partners’ servers you will create a simple installation verification process to establish a first communication between our two partner companies.



8.1 Installing Partner Agreement Manager These are the installation steps and the order in which you will be performing them. The examples below show the installation of PAM for the Down Under Insurance Company in our sample application. The same steps must be carried out for the Outback Car Rentals Company, the other partner in our sample. 1. Install MQSeries 2. Install a C++ compiler, such as Visual Studio, which is required to compile stored procedures 3. Install DB2 4. Perform database setup script tailoring 5. Create the PAM database schema 6. Install PAM Note: Compiler conflicts with DB2. If you install DB2 first, and then install Microsoft Visual Studio on the same computer, you will have ODBC driver problems and won’t be able to connect reliably to your database. This is a known problem. Installation of the C compiler, DB2, and MQSeries were performed according to product installation instructions. We will not be detailing the installation of any of these products.



8.1.1 Setup There are several scripts and command files that must be tailored for your specific software requirements prior to instantiating the database schema or installing PAM. 1. Copy the DB2_Schema directory from the PAM CD to a local drive. 2. Change directory (cd) to the new DB2_Schema directory.
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3. Edit the setenv.bat file (using NotePad) to set the variable SQLLIB to the path of where you installed DB2. Note: If you have installed under the default ‘Program Files’ directory, use the 8-character abbreviation ((PROGRA~1) instead of using a space in the path. 4. Make a copy of the sr_cpath.bat.sample file and name it sr_cpath.bat (remember to make it editable). 5. As shown below, edit this new file (using NotePad) to comment out (REM) all those compilers that do not match the one you have installed (we have installed Microsoft Visual Studio 6 in our example). .@echo off REM delete the unused lines from this file... REM ***************************************************************************** REM * Make sure that all the variables are correct * REM * Check that the correct drive is set * REM * WATCH OUT if you have installed using long names............. * REM ***************************************************************************** REM *** Using this one ****************** REM use something this for Visual Studio 6 set VCV6_DRIVE=c:\vstud6 set include=%include%;%VCV6_DRIVE%\VC98\atl\include;%VCV6_DRIVE%\VC98\mfc\include;%VCV6_DRIVE%\VC98\include set lib=%lib%;%VCV6_DRIVE%\VC98\mfc\lib;%VCV6_DRIVE%\VC98\lib set path=%path%;%VCV6_DRIVE%\Common\Tools\WinNT;%VCV6_DRIVE%\Common\MSDev98\Bin;%VCV6_DRIVE%\Common\Tools;% VCV6_DRIVE%\VC98\bin;%VCV6_DRIVE%\VC98\mfc\lib;%VCV6_DRIVE%\VC98\lib



6. Make a copy of the sqlproc.mak.sample file and name it sqlproc.mak (remember to make it editable). 7. Edit this file (using NotePad) to uncomment the name of the compiler you are using (the default is the IBM compiler). 8. Edit the file (using NotePad) to uncomment the DEBUG=YES if you wish to build with debug options. 9. Ensure that the directory \function\routine exists. If it does not, create it by using mkdir. 10.Copy the edited sr_cpath.bat and sqlproc.mak to the \function\routine directory. 11.Also copy bitwfa.dll and tocharf.dll to the \function\routine directory. 12.Edit (using NotePad) the newdb.bat file. Issue a global replace to change the drive letter if your database is not to be installed on the E: drive.
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13.Change the DB_ADMIN user ID if your DB2 administrator user ID is not “db2admin”. 14.Change the DB_ADMIN_PASSWORD if your DB2 administrator password is not “db2admin”. 15.Here we commented out BOTH of the nmake lines. This allows us to run this file and create the db2config.h file and check it first to ensure that it is as we expect. 16.Save the file. 17.Open a DOS window and go to your DB2_Schema directory. 18.Type the following command (we are going to name our database PAMDB): newdb PAMDB



19.Open (with NotePad) the db2config.h file, shown in the following figure. Check that the database will be created where you expect and with the name PAMDB



/* created by newdb.bat */ #define DB_DRIVE 'D:' #define DB_SYSCATSPACE 'D:\TABLESPACE\PAMDB\SYSCATSPACE' #define DB_USERSPACE1 'D:\TABLESPACE\PAMDB\USERSPACE1' #define DB_TEMPSPACE1 'D:\TABLESPACE\PAMDB\TEMPSPACE1' #define DB_TABLESPACE 'D:\TABLESPACE\PAMDB\PAMDB_DATA' #define DB_USERTEMPSPACE 'D:\TABLESPACE\PAMDB\USERTEMPSPACE' #define DB_TABLESPACE_NAME PAMDB_DATA #define DB_NAME PAMDB #define DB_ADMIN db2admin #define DB_ADMIN_PASSWORD db2admin



20.Edit (using NotePad) the newdb.bat file again. Uncomment whichever of the nmake commands is appropriate for your compiler. 21.Save the file. 22.We are now ready to create and configure the PAM database.



8.1.2 Creating the PAM database schema The recommended configuration of PAM and DB2 uses two computers, one to run PAM and one to run the DB2 server. We have chosen to install PAM and DB2 on the same computer. The following instructions refer to either configuration. We ran the PAM schema create as the db2admin user.
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1. Open a new DB2 command window and click Programs -> IBM DB2 -> Command Line Processor. 2. Change directory (cd) to our own created db2_schema directory. 3. Run the newdb.bat file from the DB2 command window with the following command: newdb PAMDB



After this script has been run successfully, the database configuration has been completed: • A new database for PAM named PAMDB has been created. • PAM tables have been created. • The number of log files has been extended. • All UDFs (user-defined functions) have been registered. • All stored procedures have been created. Please refer to Appendix B.2, “Programs, tools and text files” on page 448 for information about the log file that was created during the DB2 configuration. Note: The newdb command puts the DB2 stored procedures in the directory \function\routine\sqlproc\. In our example, this is \function\routine\sqlproc\PAMDB\db2admin.



8.1.3 Check the database installation Click Programs -> IBM DB2 -> Control Center. If not already logged on as the db2admin user do so. Click -> Instances -> DB2 -> Databases. Here you will be able to see the newly created PAM database PAMDB (Figure 113):
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Figure 113. Installation - PAM database in DB2 control center



Click the PAMDB icon to drop down the database components. As mentioned earlier, application objects such as user-defined functions and stored procedures are created. The control center shows a graphical representation of application objects that have been stored in \function\routine\sqlproc\, shown in Figure 114.



Figure 114. Installation - application objects defined in PAM database



Click the Stored Procedures folder to see a list of all the stored procedures that have been created and their attributes (Figure 115).
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Figure 115. Installation - stored procedures after database install



8.1.4 Installing the Process Server and Adapter Server Now that the database has been successfully created, you need to create the PAM Process Server and Adapter Server. The Partner Agreement Manager Installation and Configuration Guide has a Windows NT Installation Worksheet that should be completed prior to installing the PAM components. This provides a quick reference of all components and names that will be required during the installation process. During the installation the system selects all components by default: the Process Server and Adapter Server (which we will refer to as PAM Server or PAM), the Partnership Agreement Manager Client (which we will refer to as the PAM Client) and the Adapter Manager. You may select any combination of components. For our sample application we installed all components. However, it is important to remember that if you perform installation multiple times on a single machine only the latest installation will be valid and will overwrite any previous installation. For example, if you install the PAM Server and then install a PAM Client, the server version will be overwritten and the system will function as a PAM Client only.
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To begin the installation process, go to the PAM folder on the CD and double-click the setup.bat file. This will set up the environment correctly for the installation and start the Java runtime environment. Click the Java icon in the toolbar. This brings up the PAM installation program. Click Next. Important Note



If you are installing PAM on a dual processor machine, you must set the affinity of the java.exe to one processor before continuing with the installation. To set the affinity to one processor: 1. Open the Windows Task Manager and click the Processes tab. 2. Find the java.exe process in the list and right-click the process name. 3. Choose Set Affinity from the menu that appears and deactivate all but one processor. 4. Close the Task Manager and continue with the Partner Agreement Manager installation.



Figure 116. License agreement



In the window shown in Figure 116, accept the license terms. Click Next.
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In Figure 117, deselect any components not required. We installed all components.



Figure 117. Select components



Click Next. Enter the license key in Figure 118.
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Figure 118. Enter the license key



Click Next. In Figure 119, enter your Partner Name (company name) and Partner ID. We recommended that you use your company’s D-U-N-S number for your partner ID. The D-U-N-S number (the Data Universal Numbering System number) is provided by Dun & Bradstreet and is used to track business entities worldwide. If you have more than one PAM license in use within your company, use your D-U-N-S Number with the four-digit location or instance qualifier to distinguish the different locations within your organization. For more information on D-U-N-S numbers, please visit the Web site http;//www.dnb.com.
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Figure 119. Installation - partner name and partner ID



Note: For our sample application, we have used the IP address of our hosts as our Partner ID. Click Next. In Figure 120, check that the host name and port information for your PAM server are correct and do not conflict with any existing applications.



176



Business Process Management using MQSeries and Partner Agreement Manager



Figure 120. Port and host information for PAM server



The Process Server ports listen for the Adapter Server and the PAM Client.The Adapter Server ports listen for the Process Server and PAM Client. Note: For our sample application we used the default ports suggested in the installation procedure. Click Next. In Figure 121, enter the name of the database that you created in 8.1.2, “Creating the PAM database schema” on page 169. Click the checkbox to use the same database for the Adapter Server as for the Process Server.
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Figure 121. PAM Database information



Click Next. In Figure 122, enter the DB2 administrator user ID and password as the authorized data modification user - that is, the user that is to have read and write access to the PAM database. Click the checkbox to enable the DB2 administrator to also have schema modification rights - that is, permissions to create tables and stored procedures in the PAM database.
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Figure 122. Installation - authorized database administrators



Click Next. As part of the installation, PAM creates a user named “admin”. This user is predefined with edit access to PAM administrative functions, such as adding partners, creating business objects, and adding processes, and with read access to audit reports. The PAM admin user can also monitor running processes, audit completed ones, edit the company's Partner Agreement Manager profile, and add new users. In Figure 123, enter a password for the PAM admin user. The password can be changed later if required, after logging on as the admin user. Enter the password again for confirmation.
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Figure 123. Installation - PAM administration user



Click Next. In Figure 124, the host name and port numbers for the HTTP and Secure Socket Layer will be entered by default. For our sample application we did not use Web approvals, so leave these values unchanged.
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Figure 124. Installation - HTTP and SSL details



Click Next. PAM is able to collect system diagnostic information. To view it, click Auditor--> System Messages folder in the PAM explorer. In Figure 125, click the checkbox to enable polling for collection. The default polling interval is 5 minutes. For the purposes of our sample this is sufficient. For our sample application we did not use the SNMP agent. Do not click the SNMP checkbox or specify any trap receiver servers to listen for PAM messages.
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Figure 125. Installation - diagnostic monitoring settings



Click Next. By default, the Process Server and the Adapter Server as NT services are selected (Figure 126).



Figure 126. Installation - services entries
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However, be careful to note that the services will be started by the user ID of the user that is performing the install. This is not editable. Enter the password of the user ID to start the services. Click Next. In Figure 127, enter the host name of your SNMP server (this is the host name of your e-mail server). Enter a user name for the PAM e-mail account. All undeliverable mail from PAM will be returned to this mail account.



Figure 127. Installation - SMTP settings



Click Next. Enter the directory that you are going to install PAM. If the directory you chose for the installation does not exist, you are prompted to enable the installer to create it. Click Yes. Click Install. You will see Figure 128 when the installation is completed.
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Figure 128. Installation complete



If you have installed PAM as a service, then both the Process Server (PAM) and the Adapter Server should start automatically when you complete the installation. You can confirm that they are running clicking Start -->Settings --> Control Panel --> Services. The Process Server should be running as a service called PAM with startup set to automatic. The Adapter Server should be running as a service called PAMAS with startup set to automatic. This service is also dependent on the PAM service. If the PAM service is shut down, the PAMAS service will also be shut down.



8.2 Logging on to the PAM Client PAM configuration is carried out using the PAM Client (or explorer). The PAM Client was installed as part of the previous step. To begin PAM configuration, you must now log onto the PAM Client. Click Start --> Programs --> WebSphere BtoB Integrator --> PAM Client (). The PAM Client logon window shown in Figure 129 will appear.
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Figure 129. PAM Client login box



Enter the admin user ID and password that was set during the product installation (user names are not case sensitive but your password is). Click OK. This will take you to the PAM explorer window (shown in Figure 130) and you will continue with the PAM configuration.



Figure 130. PAM Client explorer
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8.3 Creating the PAM channel profile PAM provides the basis for exchanging information between business partners in a secure and automated fashion. Before any company-to-company communication or profile exchange can occur, each company must first set up its company profile (or PAM channel profile). A PAM channel profile includes four types of information: 1. Corporate information, which includes information that was entered when you installed PAM, such as company name and Partner ID. 2. Contact information, which identifies the primary person to contact for issues regarding PAM. 3. Communication settings, which specify the services you use to send information. 4. Security profile, which identifies policy options, cryptographic algorithms, and certificates that safeguard your communications with partners. Note: Only the admin user can initially set up or change the PAM channel profile. The admin user can then set up other users and give them permission to change the PAM channel profile.



8.3.1 PAM channel profile - general properties From the PAM explorer, click the Administration folder and then click the PAM channel General tab (Figure 131). This sample will demonstrate setting up the PAM profile for the Outback Car Rentals Company. The same configuration must be performed for the Down Under Insurance Company before any exchange can occur.
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Figure 131. PAM channel - general attributes



The properties of Partner Name and Partner ID are the company properties that were defined when you installed the product and may not be changed. The version number refers to the PAM channel profile version. Each time you revise any of the modifiable profile information (for example, to change a contact name) PAM increments the profile version number. In case of any problems, you can always verify versions with your partner and synchronize profiles if necessary. The channel name refers to the type of channel you are configuring. For our sample application, we only configured communications from PAM channel to PAM channel (that is, both partners have a full installation of PAM).



8.3.2 Create the contacts list Contact entries include information about your company and specifically identifies the primary person to contact for issues regarding PAM. This information also specifies the different ways of reaching the contact person for your company like e-mail addresses and phone numbers.
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Click the Contacts tab to enter your company contact information. You will see Figure 132. Click Add. Type the name of the contact you wish to add. Click OK.



Figure 132. PAM contacts list



Click the new entry you have added and click Properties. Enter the details of the method of contact in the Value column. In Figure 133 we have nominated an e-mail address. You may add more fields, such as a phone number, and you can arrange the order of preference using the up and down arrows in the Properties window. Click OK to close the Properties window.
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Figure 133. PAM channel - contact properties



8.3.3 Configure the communications services Click the Services tab to configure the communications services. PAM supports three types of communication services: 1. Internet, which is: - Synchronous - Via Internet or private networks 2. Dial-up, which is: - Synchronous - Modem-to-modem communication 3. Message queuing service (such as MQSeries), which is: - Asynchronous - Application and time independent When you set up communication services, you configure the service types that you use to send messages, and that your partners use to accept communications from you. The Services panel shown in Figure 134 shows the available service types.You must set properties for each of the different service types you wish to use.
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Figure 134. PAM channel - available services



Note: You must set up at least one synchronous service type (Internet or dial-up), because PAM uses a synchronous service to transport its process control messages. 8.3.3.1 Internet Service First, you will set up an Internet service. Select Internet and click Properties. You will see Figure 135.
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Figure 135. PAM channel - Internet services properties



All synchronous services must have the time-out and retry properties set. Time-out is the amount of time (in seconds) that PAM waits for a reply before cancelling a connection attempt. Retries specifies the number of times that PAM tries to send a message before giving up. As you can see in Figure 135, we have chosen the defaults as our starting point. Also, for the sample application we will not be connecting through a proxy server. Click OK to finish the configuration of the communication services. 8.3.3.2 MQSeries Service You will now configure the MQSeries Service. Select MQSeries in the window shown in Figure 134 and click Properties. You will see Figure 136.
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Figure 136. PAM channel - MQSeries service properties



Because MQSeries is an asynchronous communication service, there are no retry properties to be set. The MQSeries channel definitions will handle time-outs and retries as needed. Enter the host name of your MQSeries server. Enter your MQSeries listener port. Enter the name of the MQSeries sender channel. Enter the name of your queue manager. If a user ID and password are required by the receiving queue manager, enter these. Our sample application does not utilize an MQSeries sending service; this is shown as an example only.



8.3.4 Configure listeners The settings for a PAM listener service provides your partners with the information they need to communicate with you - they are the inbound communications. You may set up as many incoming services as you require,
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both synchronous and asynchronous. This allows for more reliable communication. If PAM is unable to connect using the first listener service listed in your profile, it tries the next service in the list, and keeps trying the services in the list until the message is received or until it runs out of time-outs, retries, and listener services. Note: PAM rolls over from one synchronous or asynchronous service to the next, but does not roll over between synchronous and asynchronous services. To set up the listener services, select the Listeners tab. This display a list of currently configured listeners. Click Add. This will display a list of available listener types (Figure 137).



Figure 137. PAM channel - available listener types



Select the Internet listener and click OK.
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Figure 138. PAM channel - Internet listener properties



Enter the host name and the TCPIP port number of your PAM server. 8001 is the default port number suggested by PAM. Select the Enabled checkbox to enable this listener. For our sample application we are not connecting through a proxy server. Click OK to end the configuration of the Internet listener. Click the MQSeries Service to create an MQSeries listener (Figure 139).



Figure 139. PAM channel - configure another listener
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Figure 140. PAM channel - MQSeries listener properties



Enter your queue manager name and the outbound queue name. Provide also the name of an error queue. Select the Enabled check box to enable this service. The names of the listeners are generated automatically by PAM, but can be overridden. For each new instance of a listener of the same type PAM will give it a name with an incrementing number (for example Internet -1, Internet-2 and so on). When rolling over between listeners PAM will start at the first listener in the list of a certain type and roll to the next listener on the list of the same type. To organize your listeners into the correct priority or sequence, use the blue up and down arrows to move the listeners to the ordered required.



8.3.5 Configure Security The PAM profile has three security components: • Standard policies • Cryptography algorithms • Authentication certificates
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PAM supports four types of standard security policies: • Privacy PAM encodes the message in a way that it can only be decoded by the intended recipient. • Authentication PAM verifies both the identity of the sender and the integrity of the message using the sender's signature certificate. • Non-repudiation origin PAM authenticates each message and maintains an audit record to verify that a message actually originated from the stated originator. • Non-repudiation receipt PAM authenticates each message and maintains an audit record to verify that a message was actually received by the intended recipient. PAM uses three types of cryptographic algorithms to implement those security policies you have selected: • Encryption Uses two variable key-size ciphers: RC2, a variable key-size block cipher, and RC4, a variable key-size stream cipher. • Key Exchange Uses RSA public-key ciphers to encrypt or decrypt private keys. • Signature Uses RSA public-key ciphers and hashing algorithms (SHA-1 and MD5), which create message digests, to generate and verify digital signatures.
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Select the Security tab (Figure 141) and choose the standard security policies to enforce. You may choose any combination of the four available policies.



Figure 141. PAM channel - security profile



We have chosen all four but we have not chosen any of the cryptographic options.



8.3.6 Create certificates A certificate is a security document that generates a public encryption key and binds it to the e-mail address of the person who signs and guarantees the authenticity of the certificate. Because the same person is both the principal and guarantor, they are referred to as self-signed certificates. PAM uses two types of self-signed certificates: 1. Signature certificates are used to sign messages when sending. 2. Exchange certificates are used by your partner to encode a private message when the privacy security option is enabled.
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It is mandatory that you define one signature certificate and one exchange certificate before you can exchange information with your partners. Select the Certificates tab. To create a new certificate, click Add. You will see Figure 142.



Figure 142. PAM channel - signature certificate



To create the signature certificate, select the Signature radio button: • Enter your name (this is the person responsible for authentication) • Enter your company name • Enter your e-mail address • Enter a start and end date for the certificate Click OK to generate the certificate. To create the second certificate click Add once more on the Certificates tab.
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To create the exchange certificate, select the Exchange radio button (Figure 143) and do the following: • Enter your name (this is the person responsible for authentication) • Enter your company name • Enter your e-mail address • Enter a start and end date for the certificate



Figure 143. PAM channel - exchange certificate



Click OK. You will see a window similar to Figure 144.
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Figure 144. PAM channel - certificates



You have now defined all the required information for the PAM channel profile. The PAM channel profile must be set up for the other company, using the same steps, before you can exchange partner information.



8.4 Creating a new PAM partner The next step in the PAM configuration is to define each company as a partner of the other. Either partner can start the process by adding the other. You begin by entering some basic information about the prospective partner so that you can send an initial message. PAM sends a copy of your PAM profile to the prospective partner and requests a copy of the partner's PAM profile in return. This example shows the Down Under Insurance Company setting up the Outback Car Rentals Company as a partner using the New Partner Wizard.
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From the PAM explorer, select File --> New --> Partner. This will bring up the New Partner Wizard window, shown in Figure 145.



Figure 145. Create new partner



Enter the company name of your new partner (Outback Car Rentals). A list of available channel types will be displayed. In our sample application we have only installed the PAM channel as both our companies will be using PAM channels. Select the channel type you will be are using and click Next. You will see a window similar to Figure 146.
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Figure 146. Create new partner - select communications services



Select the communication type that you will be using to send messages to your partner. As mentioned before, we will only be using synchronous Internet communications between partners. Select Internet and click Next. You will see the window shown in Figure 147.
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Figure 147. Create new partner - communication service information



Enter the communications service information of your partner. This is the sort of information you would have exchanged via phone or e-mail with your prospective partner, ahead of time. Enter the host name (or IP address) and PAM listener port of the Outback Car Rentals PAM server and click Next. You will see the window shown in Figure 148.



Chapter 8. Installing and Configuring Partner Agreement Manager



203



Figure 148. Verify new partner details



Review the details of the new partner and click Finish. This will send a copy of you PAM profile to your partner and will request that a copy of their PAM profile be sent to you.



8.5 Partner profile exchange PAM requires that each partner in a new PAM partner agreement review each other’s PAM profile and trust each other’s certificates. The Down Under Insurance Company has sent the new partner profile to Outback Car Rentals for distribution and acceptance. You will now look at the request from the recipients view. To view the profile distribution request that has arrived, go to the PAM explorer and select Partners --> Manager, as shown in Figure 149.
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Figure 149. A profile distribution request is sent to the partner



The message shown in Figure 150 will show that there is a profile distribution request from the Down Under Insurance Company.



Figure 150. Details of the request



Right-click the request to start the Profile Acceptance Wizard (shown in Figure 151).
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As mentioned earlier, each of the certificates from the requesting partner must be accepted as trusted before any partner exchange can take place.



Figure 151. Certificates before acceptance



Select the first certificate and click Properties. You will see a window similar to Figure 152.
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Figure 152. Certificate properties from partner



Check the details of the certificate and click the Trusted radio button to accept this certificate as trusted. You will see Figure 153.
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Figure 153. The accepted certificate is now trusted



The signature certificate is now trusted. Repeat this procedure for the exchange certificate. Both of the required certificates are now trusted. Click Next.
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Figure 154. List of communications services supported by partner



Check the communication services being proposed by your partner. To see the details of the service, or to disable any services that may not be supported by your organization, select the service name and click Properties Click Next to go to the next step in the Profile Acceptance Wizard. You will see the window shown in Figure 155.
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Figure 155. Ready to accept the partner profile



To finalize the acceptance Click Accept. You will see the window in Figure 156.



Figure 156. New partner in the PAM Client
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After you accept a partner’s profile, it can be viewed by selecting Partners --> PAM.



8.6 A simple installation and configuration verification You will now create a simple public process that will serve as both an installation verification and as a quick way to get used to navigating around PAM. What you will achieve with this verification is to establish that both partners are communicating with each other by sending a simple one-line message to each other. The author of the public process is the Outback Car Rentals Company. However, either of the two partners may author a public process, since they are both full PAM users.



8.6.1 Create a new business object To create our new business object, you must first define an element definition set. The element definition set is essentially a list of elements that make up a business object. To created a new element definition set in the PAM explorer select File --> New --> Element Definition Set. You will see the window in Figure 157.
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Figure 157. Define a new element definition set



In the Element Definition Set editor, select Edit --> New Element. You will see Figure 158.



Figure 158. Define a new element
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Create an element named “Message” with the following properties: • Field element (that is, has no subordinate elements). Click Field. • As content type, select text/plain from the drop-down values. Click OK to create this element in the database. You will see Figure 159.



Figure 159. Define an element group



Since an element definition set is a collection of elements, there must be at least one group element to tie the hierarchy together. Select Edit --> New Element to create an element named “Contact Message” and select the Group radio button. Add a meaningful description by selecting the Description tab (shown in Figure 160). Always remember that your PAM partners will be receiving a copy of all business objects and public processes that you author. Ensure that your descriptions are not only meaningful to yourself but to your partners as well.
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Figure 160. Group element attributes - description



Re-select the Content tab and select Add to add an element to the Contact Message group. As shown in Figure 161, from the drop-down box select the Message field element that was created previously.



Figure 161. Add field elements to the group element
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The Optional and Repeatable checkboxes will be left blank in this example, since the message you are sending is neither optional nor a repeating field. Click OK to end the definition of the element. As you can see in Figure 162 there is a hierarchy of field elements within the group element. Also, notice the difference in the icons for a field and group element.



Figure 162. Element hierarchy in definition set



Select File --> Save and save the element definition set as Contact Message. See Figure 163.
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Figure 163. Save the element definition set



For this simple verification, you have reached the point where we can freeze your element definition set, that is, change it from edit status to read only and consequently put in under the version control of PAM. To freeze the element definitions set, select the folder Business Objects --> Outback Car Rentals --> Element Definition Sets. Right-click the ContactMessage element definition set and select Freeze. A business object type needs to be created based on the element definition set. Select File --> New --> Business Object Type. Figure 164 will appear to select which element definition set is to be used for the business object type.



Figure 164. Select the element definition set for the new business object type



Select the ContactMessage element definition set. Note that element definition sets created by our company are always in a folder of our company name. Click OK to close the selection window.
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Select the element within the definition set that is to be the top-level element in the new business object. This must be a group element. Select ContactMessage in Figure 165 and click OK.



Figure 165. Select the required top level within the business object type



Figure 166 detailing the proposed new business object type appears.
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Figure 166. Attributes of the business object type being created



Select the Yes radio button in the Audit box to store audit information for processes using this business object type. Click Preview to see the data structure of the new business object. Figure 167 will appear.
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Figure 167. Preview the element structure



When you have confirmed that this is correct, click Close to return to main window (shown in Figure 168).



Figure 168. The business object has now been defined as being owned by our company
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8.6.2 Create a new public process The public process will determine the flow of messages between the two PAM partners. From the PAM explorer select File --> New --> Public Process. This will take you to the public process editor. The steps of the public process are built using the public process toolkit, shown in Figure 169.



Selection Tool Step Tool Branch Tool Loop Tool Branch Block Tool Loop Block Tool Figure 169. The public process toolkit



You will be defining three simple steps for this verification process. To insert a simple step, click the simple step tool in the toolkit and right-click the insertion point in the public process editor (aqua dot), as shown in Figure 170.



Insertion Point



Figure 170. Adding a process step



This becomes the first message from one partner.
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Figure 171. Add a simple step for the partner initiating the process



Add another simple step (shown in Figure 172). This becomes the return message from the other partner.



From partner one



To partner two



Figure 172. Another simple step for the recipient partner



Add a third and final simple step for the first partner to receive the response (shown in Figure 173).
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Figure 173. A final step where the recipient responds to the initiator



This is the basic structure or flow of the public process. Now each node and message must be assigned its properties. The properties tell us what is being sent and by whom.
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Figure 174. The process must be terminated to mark the end of this process flow



First, you must indicate that this is the end of the public process, as it is never an open-ended process. Since this flow is from one partner to another and back again, the third message in the graphic is superfluous. Right-click this message to bring up the Properties window (shown in Figure 174). This property would normally indicate which business object is being passed between the two partners. In this case click the None radio button. This marks this as the end of the public process with a dot (shown in Figure 175).
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Termination



Figure 175. A complete public process flow



For each step in the process you must now define who is sending what. This is known as assigning an action. Select the first partner by right-clicking it. Partners are indicated initially by an orange square. The first partner in a public process is called the initiator. In this sample, the Down Under Insurance Company will be the initiator of all public processes. Select the Down Under Insurance Company from the drop-down list of available partners. See Figure 176.
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Figure 176. Define the active partner in the public process step



For the second partner block, you, the Outback Car Rentals Company are the recipient. Select this partner from the drop-down box. For the third partner block, select the Down Under Insurance Company as the recipient, since it will be receiving the reply message. Note in Figure 177 that the icons have now changed for the partners.
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Figure 177. The public process with all participating partners identified



The circle icon indicates that this is the current partner; the buildings icon indicates that this is another partner. Each partner must eventually create an associated private process for its current partner icons. Now that you have defined who is sending and receiving, you define what they are sending and receiving - that is, the business objects that will be exchanged (known as assigning the message properties). In Figure 178, right-click the first message icon and click the Business Object Type radio button. From the drop-down list, select the Contact Message business object you have created. Click OK.
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Figure 178. Define the business object that will be sent between partners



Repeat this for the second business object. The contents of each message will be different, but you will get to that later. You now have the public process definition with all participants and business objects to be exchanged (Figure 179).
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Figure 179. The public process now has both partners and the business objects exchanged defined



To save the public process select Process --> Save and enter the process name ContactMessage in the window shown in Figure 180.



Figure 180. Save the public process



The public process is saved in the Processes folder in a folder under the name of the process author (Figure 181). When this process is distributed to other partners, they too will see it under a folder of the author.
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Figure 181. The public process is now saved as being owned by us



Before a process may be run it must first be accepted by all participating partners. To initiate this collaboration, right-click the new public process and select Process Manager. You will see Figure 182.



Figure 182. Process Manager window



A process that is under construction will be sent for review by other partners. The process manager will send it to any other partners involved in the business process. Click Send for Review in the Actions pane and click Apply. As can be seen from Figure 183, a request has been sent to the partner Down Under Insurance Company. The hourglass icon reflect that a reply has not yet been received.
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Figure 183. Process manager with a process in review



When the request arrives at the partner, a message will appear in the folder Processes --> Manager. Right-click the newly arrived message and select Process Manager (Figure 184).
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Figure 184. Partners view of request to review the new public process



The review response from the partner is not actually necessary, rather a preliminary step to get started on the distribution. The process has been sent to the Down Under Insurance Company for distribution (see Figure 185). Once the process has been distributed by the process owner, or author, the approval becomes an action item for the other partners.
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Figure 185. Process manager with a process sent for distribution



The Down Under Insurance Company must go to the process manager. Select the folder Process --> Manager and right-click the request message. Select Approve in the Actions pane shown in Figure 186 and click Apply.
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Figure 186. Public process sent to partner for approval



This sends the Approval back to the process author (Outback Car Rentals). Before moving to the test installation state, each partner must now define the private process for each step of the public process that involves them.



8.6.3 Create the private processes The private process defines any activity that takes place within the company to process or produce the business objects being exchanged. In this example we are simply using a small Java script to produce a message to send to our partner. 8.6.3.1 Outback Car Rentals (the recipient) Although Outback Car Rentals is the recipient, you will create their single private process first. From the PAM explorer double-click the ContactMessage public process to take us to the public process editor. Select the public process activity that involves us by right-clicking the icon that is labeled with our name (see Figure 187).
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Figure 187. Create a new private process



Select Private Process. This will take us to the private process editor.
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Add Script Action button



Figure 188. A new empty private process



We will go into some detail later in the book as to the different icons and their uses in the private process toolbar. For the moment, the action that interests us is the Add Script Action (see Figure 188). To add a script action select the Add Script Action tool button and right-click at the insertion point as in the public process editor. You also now need to identify which business object have been passed into the private process from the public process. To do this right-click the input objects icon in the private process editor (see Figure 189).
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Input Objects



Figure 189. Add a script action



From the public process you have been passed a variable of I1, which is of the type ContactMessage (see Figure 190). This variable will contain the message sent from our partner.



Figure 190. Default input variants for the private process



You now need to do something to look at the contents of that variable. Right-click the Script Action object to bring up the Properties window (Figure 191).
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Figure 191. Script properties - select a script type



On the Script tab, using the drop-down box, select the type of script to use. We used JavaScript, since it is available on both Windows NT and UNIX. Key in the contents of the script as shown in Figure 192.
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Figure 192. Script properties - script editor



The script will first write a string to the Process Server log, which you will see later, with the contents on the I1 business objects. It will then reset the Message element of the I1 object with a value of “ Not bad how are you”. Click OK to close the script editor. You can now test the script by setting dummy data values. As shown in Figure 193, select Tools --> Test Script.
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Figure 193. Testing the script



First, you need to ensure that the script is syntactically correct. It is worth keeping in mind that this check is a basic syntax check only and does not check that what you are doing makes any sense at all. Select Tools --> Verify, as shown in Figure 194.
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Figure 194. Script verification



When the script verification returns without an error, you see a message box like in Figure 195.



Figure 195. Script verification - OK
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You need to provide a dummy value for the inbound ContactMessage business object. To do this, select the I1 variable and right-click it.



Figure 196. The script test execution requires values for incoming business objects
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Figure 197. Insert some data for incoming business objects



Click the message element (Figure 197). In the empty pane above the element hierarchy type in a dummy message. Notice that since an element has a value, an asterisk appears next to it. Click OK when you have provided input values for all elements. When you return to the script execution window the input variable now reflects that a value have been set. See arrow in Figure 198.
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Figure 198. Input variant data has been set



To test the script select Tools --> Execute. So far so good again.



Figure 199. Successful test execution of Script Action



You now need to verify that the script changed the contents of the business object from the dummy value you set to the value in the script.
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Again, right-click the I1 variable. In the element value window (Figure 200) will now appear the “ not bad how are you” message that was set in the script.



Figure 200. Business object element values after test script execution



The other action that you must add to the private process is to output a business object to pass back to the Down Under Insurance Company. Select the Output Object Action from the toolbar and insert it after the Script Action (Figure 201).
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Output Object Action button



Figure 201. Private process with Output Object step



Right-click the Output Object Action to bring up the Properties window (Figure 202).



Figure 202. Output Object - define business object that will be output
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Here you assign the variable I1 that has a value set from the script to be the object that is sent. The type of object that this represents is a Contact Message. This is inherited from the public process. You should also label all your steps and flows where possible. Select the General tab (Figure 203) and add a description of what this is.



Figure 203. Label all steps for clarity



Before you can activate a private process you must verify that it does not contain any errors. Select Tools --> Verify. Figure 204 shows there were no errors and no warnings.
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Figure 204. Successful private process verification



You can then save your private process by selecting File --> Save. Now you are back in the public process. You need to tell the public process that your private process is correct and ready to be activated. Right-click our node in the public process and select Activate Private Process. Select our private process and save the changes. Note that this does not constitute a version change to the public process as you are only affecting your internal processing by assigning an active private process. You now need to notify our partner that you are ready to test the public process. In the PAM explorer (Figure 205), select the Processes --> Outback Car Rentals --> ContactMessage --> 1.0 folder.
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Figure 205. Select the process manager



Our public process is currently in an approved state. Right-click the process and click Process Manager. You will see Figure 206. Select Install for Testing and click Apply. This action has now sent a request for test installation to the Down Under Insurance Company.



Figure 206. Apply for test installation of public process
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8.6.3.2 Down Under Insurance Company (the initiator) Before the Down Under Insurance Company can approve test installation of the public process, it too must have valid active private process for all its public process steps. From the PAM explorer select Processes --> Outback Car Rentals --> ContactMessage --> 1.0 folder and right-click the public process to take you to the public process editor. In Figure 207, notice the difference in the icons. The Down Under Insurance Company has two local partner nodes that require private processes defined.



Figure 207. Public process editor



Right-click the first node and select Private Process.



Chapter 8. Installing and Configuring Partner Agreement Manager



249



Script Action button



Figure 208. Private process editor



Add a script action. Right-click the Script Action icon to bring up the Properties window, shown in Figure 209.



Figure 209. Script Action - label



Add a label for clarity. This script will be creating the initial “hello” message. Click OK.
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Before you create the script you need a business object to hold the contents of the message. As there are no input variable for this private process, you will need to create one. See Figure 210.



Figure 210. Create business object variable



Give this variant a name by which it can be addressed in our scripts. We chose IVPMessage. Its type is the output business object type that you are building. Select ContactMessage from the drop-down box. Give it a description for clarity (see Figure 211).



Figure 211. Business object variable



Now you have a business object “container” that can be filled.
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Right-click the script object to bring up the Properties window (Figure 212). Select JavaScript from the Script Type drop-down box and enter the script.



Figure 212. Script editor



This script will create an instance of a business object that will be stored in the IVPMessage context variant. It will also set the Message element of the business object with a value of “ Hi - how are you going?”. Click OK to close the Script Properties window. You now need to verify that the script is correct. Select Tools --> Verify. You should also run a test execution of the script. Unlike the test for Outback Car Rentals, you do not need to enter any dummy value for the message. As shown in Figure 213, select Tools --> Execute to debug the script.
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Figure 213. Script - test execution



After the successful test execution, right-click the IVPMessage variant to see the contents of the business object. As can be seen in Figure 214, the Message element has an asterisk, which indicates that the element has a value.
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Figure 214. Business object variable reflects that a value has been set



Click the Message element to see that the contents of the message is what you expect. You will see the window shown in Figure 215.
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Figure 215. Business object variable - data element value



Back in the private process editor add an Output Object Action (Figure 216). This will be the message that is passed to Outback Car Rentals.



Chapter 8. Installing and Configuring Partner Agreement Manager



255



Output Object Action button



Figure 216. Add an Output Object



Right-click the Output Object icon to bring up the Properties window (Figure 217).



Figure 217. Output Object Properties - business object to be output
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Using the drop-down box, select the IVPMessage as the variable containing the business object. The business object type of ContactMessage is pulled through from the public process. Select the General tab and give it a label (Figure 218). Click OK and select File --> Save to save the private process.



Figure 218. Output Object properties - general



In the public process editor, right-click the file local partner node and select Activate Private Process. Double-click the second local partner node to go to the private process editor and create the second private process, shown in Figure 219.
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Figure 219. Private process for second public process node



Insert a script action. Double-click the Inputs icon to see the inputs to this private process. As you can see in Figure 220, there is an input variable (I1) of type ContactMessage that has been passed from the public process. This is the message that was sent back from Outback Car Rentals.



Figure 220. Default input variables



Right-click the Script Action to bring up the Properties window, shown in Figure 221.
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Figure 221. Private process - Script Action properties



Select a script type of JavaScript and enter the script as above. This script will simply take the contents of the input message and write it to the Process Server log.
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Figure 222. Script Action properties - general



Select the General tab (Figure 222) and add a label for clarity.
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Figure 223. Script Action - script test execution



Go to the script execution window (Figure 223). Select Tools --> Test Script to run a verify on the script. Select Tools --> Verify. You should then test the script.
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Figure 224. Script Action - contents of test variable after setting



Right-click the I1 variable to see its contents. In the window shown in Figure 224, click the Message element and set its contents to some value for testing. Click OK. Run a test execution of the script by selecting Tools --> Execute.
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Figure 225. Successful script test execution



Click OK. After the successful test execution you can check the contents of the Process Server log (Figure 226) to see that the message from your script has been written to the log. The Process Server log can be found in the logs directory.



Figure 226. Process Server log after test script execution



Save the private process using File --> Save.
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In the public process editor right-click the second local partner node and select Activate Private Process. Save the private process settings in the public process using File --> Save.



8.6.4 Install public process for testing and test With both partners now having defined the private processes that support their nodes in the public process, the public process can be installed for testing and can be run. First, Down Under Insurance Company must respond to the action that was created when Outback Car Rentals sent a request to install the public process for testing. In the PAM explorer, go to the Processes folder --> Manager folder. You will see that there is a request from Outback Car Rentals. Right-click the message and select Process Manager. Figure 227 will appear.



Figure 227. Apply for test installation of public process



Click Install for Testing in the Actions pane and click Apply. This will send a response back to Outback Car Rentals to notify that you agree to install for testing.
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Once the response has been received, Outback Car Rentals can check that it has been approved by going to the process manager and checking for the tick mark against the install for testing status. See Figure 228.



Figure 228. Process manager - partner has responded



Only the process initiator (that is the first partner in the public process) may start the process. Therefore, Down Under Insurance Company must start the process. See Figure 229.



Figure 229. Test a public process
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From the PAM explorer select the folder Processes --> Outback Car Rentals --> ContactMessage --> 1.0. The public process ContactMessage now has a status of Test Installation. Right-click the public process and select Start.



Figure 230. Confirm process and execution mode



The Start Process window will appear (Figure 230). Select the execution mode Test radio button. Click OK. Since there are no inputs to the public process, you do not need to set the Inputs tab. You also do not have to set the Groups tab, because the message is only going to a single partner. This will now start the process and send a message to Outback Car Rentals. Both partners in a public process can check the status on public processes using the process auditor. From the PAM explorer (at Outback Car Rentals) select Auditor folder --> Process Logs folder --> today’s date folder.
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All processes that have been run (with audit trail on) are recorded.You will see in Figure 231 the successful completion of the test execution of the ContactMessage public process from Down Under Insurance Company.



Figure 231. Process auditor - successful completion of process



As with the script testing - the println commands in the script will now write the actual message contents to the Process Server log. See Figure 232 and Figure 233.
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Figure 232. Request message from Down Under Insurance in Process Server log



Figure 233. Reply message from Outback Car Rentals in Process Server log
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Chapter 9. Connecting to external enterprises with PAM In this chapter we will now connect the two companies, Down Under Insurance Company and Outback Car Rentals, to enable them to exchange rental car request and confirmation information. In the verification steps, we carried out a test to check that they are able to communicate and exchange simple messages. Now we will extend this to exchange purpose-built business objects in a more life-like scenario. This chapter will take us through the object definition, the public process authoring and private process definition. We will explore the use of the MQSeries adapters to send and receive messages between the companies. We will also utilize the MQSeries triggering, both via MQSeries itself and also PAM, to automate the end-to-end process flow. Finally, we will exchange messages prior to putting the entire end-to-end application together.



9.1 Setting up the sample Although the initiator of this business exchange using PAM is the Down Under Insurance Company, we will have the Outback Car Rentals company author the public processes. The public process may be authored (or owned) by either company, since they are PAM-to-PAM partners. The public process must be agreed to by all participating partners prior to being run. We have chosen to have the recipient partner author the public process to demonstrate the flexibility of the authoring and approval process.



9.2 Install the MQSeries adapter The sample application uses the adapter for MQSeries Messaging to put messages on and get messages from MQSeries queues. Before you build the private processes (for either partner) you will need to install and configure the adapters on both partners’ servers.



9.2.1 MQSeries setup The prerequisite for the MQSeries adapters is the MQSeries classes for Java. You will need to install the IBM SupportPac MA88: MQSeries classes for Java



© Copyright IBM Corp. 2001
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and MQSeries classes for Java Message Service, which contains the required components. To install this SupportPac go to: http://www.ibm.com/software/ts/mqseries



1. Select Download. 2. Select MQSeries Family SupportPacs. 3. Select Development Area. 4. Select SupportPac MA88 and download into a temporary directory. 5. Unzip the contents of the downloaded file. 6. At a command prompt, change directory to your temporary directory. 7. Type setup. 8. Select the directory for installation. 9. Follow the instructions for installation. 10.When prompted, do not restart your computer yet. Quick Tip



Be wary of the directory name you choose. Long directory names may result in your class path environment variable being too long. This will necessitate the use of the Windows shortnames - PROGR~1 etc. We installed our MQSeries software to e:\MQSeries and our Java to e:\MQSeries\Java. You must update your CLASSPATH to include the MQSeries Java class paths: 1. Select Start --> Settings --> Control Panel. 2. Double-click System. 3. Select Environment. 4. Click the CLASSPATH system variable. 5. Edit this variable to include the following: \lib\com.ibm.mq.jar \lib\com.ibm.mqbind.jar \lib\com.ibm.mq.iiop.jar \lib
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6. Click Set. 7. Click Apply. 8. Restart your computer. The final steps of the installation are to copy the adapter files to your partner directory on each partner machine and define the MQSeries objects that will be used. Ensure that you are logged on with a user ID who has administrator privileges. From the installation CD: 1. Select PAM --> MQ_Adapters --> MQSeriesMessaging1_1.zip. 2. Copy this zip file to your partner root directory. 3. Select --> PAM --> Partners -->Partners. 4. Unzip this file to the partner root directory. 5. The MQSeries adapter files will extract to the com --> extricity --> adapter --> ibm directory under the partner root directory. Go to the MQSeries Explorer: 1. Start --> Programs --> IBM MQSeries --> MQSeries Explorer. 2. You need to define a default PAM queue and a server connection channel for the adapter. This example shows the MQSeries objects for the Outback Rental Car PAM server. 3. Select Queue Managers --> M23BK67F --> Queues. 4. Right-click Queues and select New --> Local Queue.
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Figure 234. Create PAM event queue



5. Create a local queue as shown in Figure 234. in the Default Persistence field, leave as Not persistent, because this queue will be used in a similar fashion to an initiation queue for MQSeries triggering. 6. Click OK. 7. Select Advanced --> Channels in MQSeries Explorer. 8. Right-click Channels and select New --> Server Connection Channel.
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Figure 235. Create PAM svrconn channel



9. Create the server connection channel as shown in Figure 235. 10.Select the MCA tab. For the purposes of this sample application we will be using the MQSeries administrator user ID as the message channel agent user ID. For more information on this channel attribute see MQSeries Intercommunication, SC33-1872 and the MQSeries Command Reference, SC33-1369.
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Figure 236. Channel MCA user



11.Enter the MCA user as shown in Figure 236. 12.Click OK.



9.2.2 Create new adapter type Log into the PAM Adapter Manager by selecting Start --> Programs --> WebSphere BtoB Integrator --> Partner Agreement Manager --> Adapter Manager (Outback Car Rentals). Log in using the PAM administrator (admin) user ID and select Tools --> Adapter Designer. You will see a list of the currently installed adapter types (Figure 237).
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Figure 237. Adapter designer - adapter types



You now need to import both the adapter type and the adapter implementation. The adapter type contains information such as the properties of an adapter and what operations the adapter performs in an XML format. An adapter instance defines the Java source files, class names, path and package for the adapter. Select File --> Import. The window shown in Figure 238 will appear.



Figure 238. Adapter import type



Select Adapter Type and click OK. Select the directory\com\extricity\adapters\ibm\mqseries\test.
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Figure 239. Adapter type import file



In Figure 239 select the MQSeriesAdapterType.xml file and click Open.



Figure 240. Adapter designer



Select File --> Import once more. The window in Figure 240 appears. This time select Adapter Implementation and click OK. The window in Figure 241 appears.
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Figure 241. Import adapter implementation



Select the directory\com\extricity\adapters\ibm\mqseries\test. Select the MQSeriesAdapterTypeJavaImp.xml file and click Open.



Figure 242. Import the implementation file
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Figure 243. MQSeries adapter implementation



The MQSeries adapters are now installed. Close the adapter designer window.



9.2.3 Adapter instances An adapter instance specifies values for the properties in an adapter implementation. For each adapter instance you must specify the properties and operations of the adapter instance. The supplied MQSeries adapter implementation provides for the operations outlined in Table 1: Table 1. MQSeries adapter operations



278



Operation



Processing



GetUnparsed



Retrieves a message and return raw contents to private process. Message is removed from queue.



BrowseUnparsed



As above, message is not removed from queue.



GetMapped



Retrieves a message, calls a named map and returns a business object. Message is removed from queue.



BrowseMapped



As above, message is not removed from queue.



PostUnparsed



Puts a message using the raw contents.



PostMapped



Calls a map and sends a message.
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Operation



Processing



RequestUnparsed



Sends a message and wait for reply.



RequestMapped



Sends a message (mapped) and waits for a reply.



We will deal with the input and output requirements of these operations later. However, for our sample application we will be using the GetUnparsed and PutUnparsed operations, because the GetMapped and PutMapped operations do not use a suitable business object without some custom development which is not in the scope of this document. To add an adapter instance. From the adapter manager window, select Adapter --> Add. The window shown in Figure 244 appears. You will create two separate adapter instances - one for putting messages and one for getting messages.



Figure 244. Add adapter instance - general



First, create the MQSeries - Outbound instance. This instance will be used to put MQSeries messages to queues. Click the Select button for the Adapter Type entry field.



Chapter 9. Connecting to external enterprises with PAM



279



A list box with the installed adapter types will appear (Figure 245).



Figure 245. Installed adapter types



Select the Adapter Type for MQSeries Messaging and click OK. Since there is only one adapter implementation for this adapter type, the Adapter Implementation field will contain Adapter Java Imp for MQSeries Messaging. Select the Properties tab (Figure 246).
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Figure 246. Adapter properties



All adapter properties that are marked with a red check are mandatory and must be entered. To edit the properties click the required property and select Edit. Select the Channel properties and click Edit.



Figure 247. Enter channel property



The channel property value shown in Figure 247 is the name of the MQSeries server connection channel that was in 9.2.1, “MQSeries setup” on page 269.
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Click OK and select the host name property in the window shown in Figure 248., “Enter host name property” on page 282. Click Edit.



Figure 248. Enter host name property



Enter the host name of your MQSeries server. Click OK and select the QueueManager property. Click Edit.



Figure 249. Enter queue manager property



Enter the name of your queue manager in the window shown in Figure 249 and click OK. This now completes all the mandatory property values. Select the Error Handling tab.
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Figure 250. Error recovery properties



In Figure 250, select Enable auto-recovery. Allow a 10-minute recovery interval with 10 retries. Click OK.
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Figure 251. Adapter environment



Select the Environment tab (Figure 251)and use the (default) system’s class loader. Click OK. The initial test for an adapter instance is to check that it will start up and shut down. This will check that it can connect to the queue manager.
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Figure 252. Start the adapter instance



In the window shown in Figure 252, right-click the MQSeries - Outbound adapter instance and select Start. The traffic light that is currently red will turn to green once the adapter instance is running. Quick Tip



If your adapter instance will not start up due to an error, check the adapter server log for the MQSeries return and reason code.This log can be found in \logs\AdapterServer.log. Click the adapter instance again and select Stop. The traffic light will return to red. You will now create an MQSeries - Inbound adapter instance for getting messages from queues. We have defined one instance for each type of operation as we will be polling for incoming messages on the inbound instance but not the outbound instance, which requires different properties. Select Adapter --> Add.
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Figure 253. Add adapter - MQSeries inbound



In the window shown in Figure 253, create an instance with the name MQSeries - Inbound and select the adapter type for MQSeries messaging.
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Figure 254. Adapter properties - general



In the window shown in Figure 254, select the Events tab.
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Figure 255. Event polling



Select Enable polling for events. Set 30 seconds as the polling interval. This will cause the adapter server to poll the default queue (which we nominated in the properties) every 30 seconds for the arrival of messages. Select the Properties tab. Select the Channel property and click Edit. Enter the name of the server connection channel shown in Figure 256 and click OK.



Figure 256. Channel name property



Select the DefaultQueue property and click Edit.
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In the window shown in Figure 257, enter the value PAM.ADAPTOR.INITQ, the name of the queue that you created in 9.2.1, “MQSeries setup” on page 269.



Figure 257. Default queue for polling



Click OK and select the QueueManager property as shown in Figure 258. Click Edit and provide the name of your queue manager. Click OK.



Figure 258. Instance properties
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Click OK to close the Add Adapter Instance window. You now need to test that this adapter instance starts up and shuts down correctly. Right-click on the adapter instace and select Start, as shown in Figure 259.



Figure 259. Start adapter instance



After configuration and initial testing of the MQSeries adapters for both companies, you are now ready to define the business objects that are used by the adapters.



9.2.4 Import the business objects The MQSeries adapters use a business object called MQSeriesMsgOptions which contains the queue name and correlation ID to be used to get and put messages. This business object definition must also be imported. Return to the PAM Client and select Tools --> Import/Export Manager --> File --> Open for Import as shown in Figure 260. Select the directory \com\extricity\adapters\ibm\mqseries\test
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Figure 260. Import / Export Manager



Select the file MQSeriesMsgOptionsBO.xml in Figure 261 and click Open.



Figure 261. Business object import file



This will bring up a list of all the business objects in the import file that are eligible for import. In the window shown in Figure 262, click the MQSeriesMsgOptions business object and select Import.
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Figure 262. Business objects for import



A message will pop up advising that the import operation has completed successfully. A new business object type of MQSeriesMsgOptions has now been added to the Extricity folder (Figure 263).



Figure 263. New business object type



Double-click this new business object type to review its properties. As you can see there is no Key Field.
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Figure 264. Business object properties



Select the Preview button to display the elements contained in the business object. These are the QueueName and the Correlation ID for the message descripter. Double-click the MQSeriesMsg Options element definition set to see the elements that will be filled to be passed to MQSeries (shown in Figure 265).
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Figure 265. Extricity element definition sets



In Figure 266, you can also see from the display of the element definition set that a question mark is next to each field



Figure 266. MQSeriesMsgOptions elements



This indicates that in the definition set, this element is optional. This does seem a bit strange for an MQSeries queue name to be optional for a put or get operation.
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Now you should look at the business object type to see the implementation of the element definition set. See Figure 267.



Figure 267. Extricity business object type



Chapter 9. Connecting to external enterprises with PAM



295



Figure 268. Extricity business object type



In Figure 268, you can see that there is no Key Field for this business object type and that the audit trail option has been set to on. You now have the MQSeries adapter requirements completed and need to create all the customer business objects and processes for the application.



9.3 Create business objects First you need to create the elements and their element definition sets. Elements are the “building blocks” of the business object you will create. The element definition sets will define the structure of the business objects that you will create and exchange with your trading partners. We have worked with our trading partner, Down Under Car Insurance Company, to analyze and agree on the content and structure of each of the business objects that we will be exchanging via PAM. The results of this analysis will give the data we require to create the element sets for your business objects.



9.3.1 Create new element sets Log on to the PAM explorer. Select Start -->Programs -->WebSphere BtoB Integrator -->Partner Agreement Manager -->PAM Client (Outback Car Rentals).
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Once you are in the explorer request a new element definition set. Select PAM -->New -->Element Definition Set. This brings up the element definition set editor. First, you are going to create the element definition set for the Car Rental Request that will be received from the Down Under Insurance Company. You need to define each of the data elements that will be in this element definition set. This set will define the structure of the business object you are going to create. First you need to create all the elements in the set. Select Edit -> New Element. Or from the tool bar select the Create New Element button, as shown in Figure 269.



Figure 269. Element editor - create new element



As shown in Figure 270 and Figure 271, fill in the properties of the new element: Name



CustomerID.



Content



Click the Field radio button. This indicates that this element has no subordinate fields.



Content Type



Select text / plain from the drop-down list.



Content Length



We set at 10. This value is not mandatory, but for the sake of completeness and for future information purposes, you should add it.
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Figure 270. Element editor - content type drop-down selections



Figure 271. Content properties of new element - Customer ID
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Now select the Description tab and add a description (Figure 272). It is extremely important that anywhere a description is allowed that one be added for clarity and future manageability. Remember that these definitions will be sent to your trading partners. It is important that they understand what they are receiving.



Figure 272. Description properties of new element - CustomerID



Create the new element by clicking OK.
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Figure 273. Element editor - element list



You now need to repeat this procedure to create field element definitions for all elements in the Car Rental Request. Note: all of these elements will be plain/text. See Table 2. Table 2. Elements in Car Rental Request



Element Name



Element Length



CustomerID



10



ClaimReference



15



CustomerSurname



25



CustomerName



25



DeliveryLocation



25



After these field elements have been defined you now need to create a group element that will become the top level of this element set.
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Select Edit -> New Element. Name this element RentalCarRequest and select the Group radio button. You will notice that after the Group radio button is selected, the content type and length fields are now replaced by a box with an add button. See Figure 274.



Figure 274. Add group element - RentalCarRequest



As shown in Figure 275, select the Description tab and add a description for this element group.



Figure 275. Description properties - new group element
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Now select the Content tab (shown in Figure 276) to add the field elements to the group element.



Figure 276. Add fields elements to group element



Click the Add button. You will see Figure 277. a. Select the drop-down list of available elements in the Type column. b. Select the element for CustomerID. c. There are two other columns optional (if this element is not mandatory) and repeatable (if this element may be repeated). Do not mark either of these boxes, because neither applies to this sample. Repeat this step adding all the defined elements to this group in the order laid out in Table 2 on page 300. Click OK to complete the group element definition.
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Figure 277. Group element with all field elements



Your element editor will now have all the field elements and the group element listed. Group elements are always shown in bold, with an icon that indicates that this element contains subordinate elements. See Figure 278.



Figure 278. Element editor with field and group elements



To see the structure within the group element that you have just created, click the drop-down window in the Element Tree view (Figure 279).
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Figure 279. Element editor - element tree view



Select the top level element, which in this case is the group element RentalCarRequest. The view in the Element Tree will now show the structure or hierarchy of elements in the RentalCar Request group. The properties of any of the elements may be viewed by right-clicking the element and selecting element properties from the menu.



A Quick Tip



If you find, as we have in Figure 280, that you have put your elements into the group in the incorrect order, this can be easily resolved by clicking the element you wish to move and using the blue up and down arrows in the tool bar to move the element up or down in the hierarchy.
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oops!



Figure 280. Hierachy of elements with RequestRentalCar group



Save the element definition set by selecting File -> Save. In the window shown in Figure 281, enter a name, CarRentalRequest, for the element definition set and click OK.



Figure 281. Save element definition set



Go back to the main PAM explorer window. You will now see in the Business Objects folder that your newly created element definition set has been placed in a folder for business objects defined by us, Outback Car Rentals (Figure 282). When your business object definitions are sent to your trading partners they will also appear in a folder with your partner name. This will indicate to your partners that you are the owners of that business object definition.
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Figure 282. PAM explorer view - element definition sets



We need to create another element definition set for the rental car confirmation. The field elements must be as shown in Table 3. Table 3. Field elements in rental car confirmation



Field Element



Element Length



CustomerID



10



ClaimReference



15



VehicleRegistration



10



VehicleMake



10



VehicleModel



10



VehicleColour



10



DeliveryTime



4



OurReference



10



The group element for this definition set will be RentalCarConfirmation and will contain all of the above elements in the order listed (see Figure 283).
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Figure 283. Element tree view - RentalCarConfirmation



Quick Tip



When defining names of elements and element definition sets, you may not use imbedded spaces. Either use underscores or, as we have done, use case to denote new words to make your names meaningful. Consider your business partners.



9.3.2 Create new business object definition The business object definition is the Buildtime representation of a business object. Its definition is based on an element definition set. The business object definition is used to create the business object, which is the Runtime instantiation of a business object type. You take the element definition sets created in the last section and create business object types from them. From the PAM explorer, select PAM -> New -> Business ObjectType.



Chapter 9. Connecting to external enterprises with PAM



307



You will be prompted to select the element definition set you wish to use to create a business object.



Figure 284. Select element definition set



As shown in Figure 284, expand the drop-down list for your own element definition sets, Outback Rental Cars, and select CarRentalRequest. Click OK. You will see the window shown in Figure 285, where you will select the top level element for this business object type.
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Figure 285. Select top-level element for business object type



Select the group element RentalCarRequest and click OK. The proposed business object type is shown to you. In the window shown in Figure 286, note that the name of the business object type is the same as the top-level element name from the element definition set. There currently exists a restriction that you may only create one business object type per element definition set.
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Figure 286. Proposed business object type



You now have three further steps to perform before accepting and therefore creating this business object type. • Set the audit flag The audit flag determines whether instances of this business object type are subject to audit during Runtime. By default all business objects are preset with audit turned on. If audit is turned on, you will be able to extract the contents of messages that are sent or received using this business object type. Once this business object type has been frozen (that is, set from edit mode to read-only mode, the audit flag may be switched on or off without changing the business object. You will leave the audit function enabled for your business object types. Important: If you turn off auditing for a business object type, non-repudiation support is also disabled for all messages that contain this type of business object. • Set the Key Field value The Key Field value may be queried. The Key Field value does not have to be unique, because it is not a key in the usual database sense of the word. Audit data is held in the PAM database as both an XML blob and with the Key Field values stored in a separate field that can be queried. Basically the only real restriction is that it may not be a repeatable field. Setting the Key Field value should also be mandatory within the business object.
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Click the Set button in the Key Field area. A list of all elements in the definition set will be displayed (Figure 287).



Figure 287. Set the Key Field



Click the field that will be used as the Key Field. For our example we are using the Customer ID. When you are returned to the Business Object Type window, check that the Key Field value now has the selected element (Figure 288).
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Figure 288. Key field setting in business object



• Preview the element hierarchy All that is left to do is to preview the structure and elements of the new business object. Select the Preview button. You will see a window like Figure 289.



Figure 289. Preview new business object
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Note that the Key Field is shown on the display. If this is all correct, click Close. When you are returned to the business process window, select OK to create the RentalCarRequest business object type. You will now create a business object type for the rental confirmation element definition set. As before, from the PAM explorer select PAM -> New -> Business Object Type. You will see a window like Figure 290.



Figure 290. Select element definition set for new business object type



Select the CarRentalConfirmation element definition set and click OK. The window shown in Figure 291 will appear. Select RentalCarConfirmation as the top-level element in the new business object. Do not change the audit settings and select the CustomerID as the Key Field value for this business object. Preview the element hierarchy and click OK.
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Figure 291. New business object type for RentalCarConfirmation



All business object types and their element definition sets must be frozen, that is made read only, prior to the distribution of a public process that references them. However, we will first define the public process. Note: Once a business object definition is frozen it immediately becomes subject to change and version control.



9.4 Define the public process A public process is the flow of data and information exchanged between partners. For any public process that involves PAM partners, it must be agreed to by all partners involved in the process (but more on that later). As mentioned in Chapter 7, “Basics of Partner Agreement Manager” on page 159 a public process may be authored by any PAM partner. In this sample, the Outback Car Rentals Company will author, and consequently own, the public process but the Down Under Insurance Company will initiate the process. Again, this illustrates that either of the full PAM partner participating in the public process collaboration may own the process itself. From the PAM explorer select PAM --> New --> Public Process. This will take you to the process builder window.
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Our sample public process consists of three simple steps: 1. A request for a rental car is sent from Down Under Insurance to Outback Car Rentals. 2. The request is received by Outback Car Rentals and a confirmation is sent back to Down Under Insurance. 3. The confirmation is received by Down Under Insurance. Using the process builder you build the logical process flow between the two partners. Each new step consists of an unnamed partner action and an unidentified message. You can leave the action and message as they are and continue to build the process flow, or you can assign properties to them as you go. For clarity, assign properties to each of the steps as you add them. To add the first simple step to your process click the Simple Step icon on the tool bar, shown in Figure 292. This will add an insertion point (small turquoise circle) at any point in the flow that you are currently able to add a step.



Simple Step Branch Loop Branch Block Loop Block



Figure 292. Process builder tools
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Insertion Point



Figure 293. Adding a new step to the flow



Click the insertion point required (Figure 293) and the step you have selected (simple step) is inserted into the flow (Figure 294).



Figure 294. Simple step in process flow



You now need to assign the properties to the process step. Each step has to be assigned to a partner. This first action must be assigned to the Down Under Insurance Company, because they will be initiating the public process. To assign the step properties, right-click the partner icon in the step. You will see the window shown in Figure 295.
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Figure 295. Step properties - general



As we mentioned earlier, it is vital that you label everything that you can. This ensures that the intent of each step of your business process is clearly identifiable to the partners you distribute it to. On the General tab, label the first step in your process - Send Request for Rental Car. This may sound a little obvious but that is exactly what we want. Add a description as shown in Figure 295. You now need to select the partner that will be the initiator of this process step, because this is the first process in the flow. Select the Partner tab (as shown in Figure 296) and select the Down Under Insurance Company from the drop-down list because they will be the partner sending the request message. Click OK to close the Step Properties window.
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Figure 296. Select partner for simple step



You must now define the message (in this case business object type) that the Down Under Insurance Company will be sending and assign its properties. Right-click the business object and select Properties.



Figure 297. Simple step - partner and business object



Select the RentalCarRequest business object type from the drop-down list shown in Figure 298.
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Figure 298. Select a business object type



As shown in Figure 299, select the Communications tab. Both of our partners have an Internet service and listener defined so they will be using synchronous message exchange. This is one of the details that should be decided when the two partners discuss the business process requirements.



Figure 299. Message properties



Select the Synchronous radio button and click OK.
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Add another simple step to the public process definition. This step will define who receives the message and what is sent back in response. Right-click the action or partner button, as shown in Figure 300.



Figure 300. Second public process step



Select the partner for this action. It is important to remember that the partner assigned to the action is the partner who will have a private process for that acting.
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Figure 301. Passing a partner to an action



Select the General tab (Figure 301) and add a description for this action. The label for this acting is what will appear in your process builder window.



Figure 302. Select partner



Select the Partner tab (Figure 302) and select Outback Car Rentals fro the drop-down list. Select OK.
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In the window shown in Figure 303, notice that now the two action nodes have a different icon. The circular icon identifies Outback Car Rentals as the current partner and the factory icon identifies any other partner in the public process.



Figure 303. Message properties



Right-click the message and select Properties.
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Figure 304. Business object type



Select the Contents tab (Figure 304) and select RentalCar Confirmation as the business object type to be sent. Select the Communications tab (Figure 305)and again select Synchronous for the service type.



Figure 305. Communications



Note: Although we are using MQSeries for private processing at each company, we have intentionally set this application up to be able to run between the two external companies to demonstrate that synchronous
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communications can be used if not all parties have MQSeries installed or maybe choose not to use MQSeries for external communications. Another, final, simple step in the public process will allow the Down Under Insurance Company to receive the confirmation message back from its partner and complete the process. Select the last action icon and right-click for its properties. Select the General tab and give it a description. Select the Partner tab (shown in Figure 306) and select Down Under Insurance Company from the drop-down list. Click OK to close this Properties window.



Figure 306. Final partner



Select the message icon and right-click for its properties. Select the None radio button to terminate the process and click OK to end this step.
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Figure 307. Message Properties to end the flow



You now have the complete public process definition (Figure 308) where the Down Under Insurance Company sends a RentalCarRequest to Outback Car Rentals. Outback Car Rentals receives this RentalCarRequest and sends back a RentalCar Confirmation. This is in turn received by Down Under Insurance Company and the process is complete.
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Figure 308. Public process definition



You should now be in a position to verify the public process definition for correctness and completeness. Select Tools --> Verify. You will see the window in Figure 309.
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Figure 309. Verify public process - error log



You will receive error messages to alert you to the fact that your business process definitions are still in edit mode. To see the offending message or action in the public process you may click the error in the verify window and PAM will highlight the message or action in the public process.



9.4.1 Freeze the business objects and distribute process As you define element definition sets, you might want to make changes. Therefore, PAM allows you to revise element definition sets freely before committing to version control. When you reach a point where you're ready to distribute a public process that includes a business object type based on a particular element definition set, you simply freeze the element definition set to institute version control. Its state changes from Edit to Read, which means that no further changes can be made to the current version. Although you can refer to a business object type in a process before its element definition set is frozen, you cannot distribute the process for implementation.
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Figure 310. Edit mode element definition sets



Return to the PAM Client (Figure 310) and select the Element Definition Sets for Outback Car Rentals. Right-click the first element definition set and select Freeze, as shown in Figure 311. This will not only freeze the element definition set, it will also generate the class files for this set and freeze the business object. Repeat this for both sets.



Figure 311. Freeze element definition set
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Figure 312. Verified public process



Return to your public process and run the verification again. You will receive a pop-up window (Figure 312) containing no errors or warning. Select Process --> Save As and name this public process Rental Car (see Figure 313). Click OK to confirm the save operation.



Figure 313. Save public process
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Figure 314. Rental Car process



As shown in Figure 314, the new public process will appear in the processes list under a folder of the name of the owner/author (Outback Car Rentals). This will be true of whichever partner is looking at the process. Now that the public process has been defined and verified it must now be distributed so that it can be approved and so that the partners may define and build their underlying private processes. The first step in the process is to distribute the public process to the other partner for review. Go to the Process Manager (Figure 315) and select Review and click Apply.
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Figure 315. Send for review



There is no action required from the partner. It is more of a courtesy call. That is, it does not put an action message in your partner’s Process Manager folder. So you can move straight to Distribution.
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Figure 316. Distribute for implementation



As shown in Figure 316, select Distribution for Implementation and click Apply. This now allows your partner to approve the process and start implementing its private processes. An action item will appear in the Processes --> Manager folder of the partners receiving the request. Each partner must review the public process definition and approve it - if they agree - in the process manager. This will send a response to the sending partner. The public process is now at a stage where the private processes of each partner must be defined.



9.5 Define the private processes In the sample application, you will require one private process for each of the actions in the public process. The Down Under Insurance Company will require one to send the rental car request and one to receive the confirmation message. Outback Car Rentals will require one that both receives the request and produces the confirmation. The Down Under Insurance Company will utilize PAM event triggering to initiate processing and the MQSeries adapters to retrieve the message from its back-end system, and will also utilize the MQSeries adapters to put the
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confirmation message to a queue to be picked up by its back-end system processing. Outback Car Rentals will utilize the MQSeries adapters to create a message to be put to an MQSeries queue, MQSeries triggering to initiate back-end processing (which will retrieve the message process and put a confirmation message to a queue), and the MQSeries adapters to retrieve that message to be formatted and passed back to the partner using PAM.



9.5.1 Outback Car Rentals As Outback Car Rentals has both the least number of processes and the least complex process, we will start by defining their private process first. From the PAM Client, select Processes --> Outback Car Rentals --> Rental Car --> 1.0. Right-click the Rental Car process and select Open. Right-click the action for Outback Car Rentals and select Private Process.



Figure 317. Define private process



You will now be in the private process editor (Figure 318).
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Figure 318. Outback Car Rentals private process



Figure 318 shows the completed private process with all steps. You will now build up this process. PAM uses variables in both public and private processes. You should think of variables as temporary storage containers for the information moving within a process. There are two types of variables: variants and business object variables. A variant is a single field variable that stores text strings. You would normally use these to store single field elements or flags.
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Business object variables are an instance of a business object within a process used to store or move information. You would normally use them as input to mapping actions, as output from extension actions or as input or output from script actions. There are certain default variables that PAM creates in a private process, for input and output, depending on the structure of the public process. Select View --> Variables (Figure 319) to see a list of variables in your private process.



Figure 319. Input variables



As you can see in Figure 320, the variable is of the same type as the business object in the public process. In this case, the public process passes a variable for the RentalCarRequest business object (seen here as I1). The purpose of this variable is to provide a convenient notation for input variables in scripts.



Figure 320. Default variables
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The first step in the process requires that you create an MQSeries message from the input received from the public process. This input, as can be seen above, is referred to as I1. Add a script action to the process and label it Create MQSeries Message from inbound. Select the script properties and edit a Java script as shown in Figure 321.



Figure 321. Create MQSeries message script



There are a couple of points of interest in this script. First, we are referencing both a text variant Message and a business object MessageOptions. Both of these will have to be defined as variables in this process, which you will do next. Also, the MessageOptions variable is instantiated by the use of the CreateBO procedure. The instance is then stored in the process business object variable. The other interesting point is the way in which we have constructed the message. We could have also achieved this by creating a customer adapter of our own which would perform a PutMapped extension and map our RentalCarRequest business object as a message. However, the solution is constructed this way to further illustrate that messaging with customized business objects is easily possible “out of the box”.
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Select Variables --> New Business Object. You will see the window in Figure 322.



Figure 322. MessageOptions variable



Name this variable ”MessageOptions” and model it on the MQSeriesMsgOptions object. In Figure 323, select Variables --> New Variant and name this variant “Message”.
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Figure 323. MQSeries message variant



You now need to add an extension action to your process. An extension action allows PAM to communicate with an external application such as MQSeries. The operations you can perform depend on the PAM adapters you have installed and the adapter instances you are running. You will see the window in Figure 324. One of the business objects that is used by the adapters and extension actions is the Operation_Status. It returns to the extension action the return information of the extension action operation, for example MQSeries completion and reason information. You need to define this in your process. Select Variables --> New Business Object.
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Figure 324. Return codes variable



Name this business object ReturnCodes and select the Operation_Status business type. Add an extension action to your process and label it ”Put Message to Request Queue”. Select the Extension tab (Figure 325). This will give you a list of the extensions available including the MQSeries adapter instances that you have defined previously.
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Figure 325. Extension Action



Select the MQSeries Inbound. There are some variables that will be required for this extension operation. For expediency you can define them now. As shown in Figure 326, create a new variant named TimeOut. This will act as a flag if a timeout condition occurs.
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Figure 326. Timeout variable



We will also need a business object variable for the RentalCarConfirmation message later in this process, so define that now too (Figure 327).



Figure 327. Variable Confirm
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Figure 328. All required variables



You now have all the required variables to continue (Figure 328). There are four sets of properties that you must set in for an extension object: • General is where you select the adapter instance that you wish to run • Inputs and Outputs are where you bind the required input and output for the adapter instance to local variables in your private process. The adapter instance you select will determine the inputs and outputs required. • Execution is where you set termination conditions for the extension action. You can set this to simply wait until the action is completed or you can set a timeout interval. The advantage of setting a timeout is that you can capture the timeout information in the variable that you have defined. In the extension action properties, select the Properties button. On the General tab (shown in Figure 329), select Advanced for operation type (all of our MQSeries operations are under the Advanced category). In the advanced window select PutUnparsed. This will allow you to send a string of message data.
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Figure 329. MQSeries inbound - general



Select the Inputs tab (shown in Figure 330), select MQOptions and click Set.



Figure 330. MQSeries inbound - inputs
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Since you have defined MessageOptions, a business object variable of type MQSeriesMsgOptions, this will be present in the Select Bindings window, shown in Figure 331. Select this variable.



Figure 331. MQSeries inbound - input binding



Select the variable InputVar and click Set. As this binding is for a variant, all variables that are variants will be presented. In the window shown in Figure 332, select the variant Message.



Figure 332. MQSeries inbound - inputs
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Figure 333. MQSeries inbound - outputs



Select the Outputs tab (Figure 333), select StatusBO and click Set. Again, since you have defined a business object variable of the correct business object type, this is displayed. Select ReturnCodes.
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Figure 334. MQSeries inbound - execution



Select the Execution tab (Figure 334) and modify the timeout to 5 minutes. Select the Terminate action after timeout checkbox. Select the TimeOut variable from the drop-down list and click OK. Add a script action into the process and label it: Set up the MQSeries options for queue and correlid. Edit the script as shown in Figure 335. This will instantiate the MessageOptions business object variable and fill in the name of the queue that the confirmation message will arrive on.



Figure 335. Set up the message options
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Note: We did not use the request/reply adapter functionality here, as the return message has little or no functional interest to us without using a customer adapter. Add an extension action to the process. This will perform the get message operation. Label this “Get the Confirmation Message to send on”. Select the MQSeries Outbound extension action and select Properties. You will see the window shown in Figure 336.



Figure 336. MQSeries - outbound
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Figure 337. MQSeries outbound - general



Select the General tab and choose an Advanced operation type of GetUnparsed. Again, we could have written a custom adapter to Get and Map a business object, but we have chosen to use an “out of the box” solution. As shown in Figure 338, select the Inputs tab and choose MessageOptions again as your MQOptions business object container.
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Figure 338. MQSeries outbound - inputs



Select the Outputs tab (Figure 339). You will again need the ReturnCodes business object and you will require a variant to contain the MQSeries message returned. Select Message.
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Figure 339. MQSeries outbound - outputs



Select the Execution tab (shown in Figure 340)and set the timeout interval to 5 minutes and select the TimeOut variant.



Figure 340. MQSeries outbound - execution
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You now need to add a Branch Block to your process. A branch block consists of a branch, with two alternate paths, and a script before and after it. The first script is used to set up the branching conditions. Enter the branch block after the MQSeries outbound extension action and label as follows. Select the first script action and label it “Did we get the message???”. This will be the condition for the branch. Label one branch Msg and the other NoMsg. You also need to add a Termination action to the branch of NoMsg. To do this, simply right-click the Termination button (the STOP sign) and then right-click the insertion point on the NoMsg branch. Label this “No Message Received”. Label the script action at the bottom of the branch block “Build the outbound BO from the contents of the message”. Select the Did we get the message Script Action and edit a JavaScript script as shown in Figure 341. This will test the contents of the result element of the ReturnCodes business object and set the path to Msg if the operation was successful, or to NoMsg if the operation was not successful.



Figure 341. Did we get the message script
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Select the Terminate action and the Action tab (Figure 342). Select a reason from the drop-down list. Note: This list contains all the standard supplied reasons, you are able to create and use your own reason code to make the reason more meaningful to your application. The text entered into the Details field will appear in the process audit logs in the event of an error.



Figure 342. Terminate properties



Select the last script in the branch block and edit a JavaScript script as shown in Figure 343.
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Figure 343. Build the output BO from the contents of the message



This is the reverse of what was done in the input message. You are taking a text message string and breaking it up to fill the contents of a business object. In the real world this would be achieved by a GetMapped custom adapter instance. Have a look at the supplied GetMapped, which maps to an Example_InventoryItem business object. The business object being instantiated is named “Confirm”, which represents the RentalCarConfirmation business object.
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Figure 344. Output Object



Finally, add an Output Object Action to the process (Figure 344). Select the business object Confirm, which represents the RentalCarConfirmation business object to be sent back to the Down Under Insurance Company. Verify your process and save it. Return to the public process editor. Right-click the Outback Car Rentals process and select Activate Private Process.



9.5.2 Down Under Insurance Company As mentioned earlier, the Down Under Insurance Company is both the initiator of the process and also the recipient of a response. Therefore there are two private process definitions required. These must be defined on the Down Under Insurance Company’s PAM server because each private process must be defined by its owner. 9.5.2.1 Sending private process For the ‘Sending’ private process you will use PAM event triggering to start the public process. This will not only start the private process, but will also pass the contents of the input variable from the public process into the private process. See Figure 345.
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‘Sending’ Private Process



‘Receiving’ Private Process



Figure 345. Down Under processes



PAM expects input variables to be provided to the process when it starts running. Each time you start a process, PAM inserts any current values into the variables you have defined. We will define an input variable for the public process that will be filled in when triggered (you will do this later) and the value will be passed into the private process. From the public process editor, select Variables --> New Variant. You will see Figure 346.
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Figure 346. Global variable



Name this variant ”InputMessage” and select Input as its usage. This variant is seen in the public process window (Figure 347) as global, since it is now available to the private process it initiates.



Figure 347. Input variant
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Figure 348. Sending private process



Figure 348 is the ‘Sending’ private process for the Down Under Insurance Company. From the public process editor, right-click the first of the Down Under Insurance Company actions and select Private Process. Because you will be sending a RentalCarRequest object to the partner, you will require a business object variable. Select Variables --> New Business Object. You will see the window shown in Figure 349.
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Figure 349. RentalCarRequest - variable



Name this variant “RequestRentalCar” and select a business object type of RentalCarRequest and click OK. First, add a branch block action to the private process. Select the first script action and label it “Get Message”. Select the first branch and label it”Msg”. Select the other branch and label it “NoMsg”. Add a terminate action (the Stop sign) at the insertion point on the NoMsg branch. Select the script action after the branch and label it “Set up the outbound BO from the contents of the message”.
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Figure 350. Get Message script



Edit the JavaScript as shown in Figure 350. This will check whether there was an MQSeries message passed from the public process. If the input variant is empty the processing will branch to NoMSg. If the variant is not empty the processing will branch to Msg.
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Figure 351. Terminate properties



In the terminate properties window shown in Figure 351, set the reason to Missing Data in Business Object and add some details to appear in the audit log in the event of an error.
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Figure 352. Create BO script



Select the Set up the outbound BO script and edit a JavaScript as shown in Figure 352. This script will instantiate the RequestRentalCar business object variable and string the contents of the message into the field element of the business object.
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Figure 353. Output Object



As shown in Figure 353, add an Output Object Action to send the RentalCarRequest object. Label this as “Rental Car Request” and select the RequestRentalCar variable to represent the RentalCarRequest business object. Verify the private process and save it. Return to the public process editor. Right-click the first Down Under Insurance Company process and select Activate Private Process. 9.5.2.2 Receiving private process The ‘Receiving’ private process is the final step in the processing for the rental car request business process. It will take the RentalCarConfirmation business object returned from Outback Car Rentals and place it as a message on an MQSeries queue for processing by the back-end systems at the Down Under Insurance Company.
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Figure 354. ‘Receiving’ private process



Figure 354 shows the private process definition for receiving the confirmation message.



Figure 355. MessageOptions variable



Again, you will need a process variable to represent the MQSeriesMsgOptions business object. As shown in Figure 355, create a business object variable named ”MessageOptions” to represent MQSeriesMsgOptions.
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You will also require a variant to represent the MQSeries message. As shown in Figure 356, define a new private process variant named “Message” of type Variant.



Figure 356. Message variant



As shown in Figure 357, create another variant named “TimeOut” to represent the Timeout variable.
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Figure 357. TimeOut variant



Finally, as shown in Figure 358, create a new business object variable named “ReturnCodes” to represent the Operation_Status business object.



Figure 358. ReturnCodes variable



Add a script action and label it”Create the message from the BO received”. Edit the JavaScript as shown in Figure 359.
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Figure 359. Script action - Create message from BO received



This will take the contents of the elements of the business object and concatenate them into the Message variant to represent the MQSeries message. It will also instantiate the MessageOptions business object variable and set the queue name and CorrelationID of the message. Note: all the Down Under Insurance Company message processing in the sample application is based on the CorrelationID being that of the CustomerID. You will also note that in all the private processing scripts there have been println procedures that will write eye-catching messages to the Process Server logs. Add an extension action to the process and label it “PUT MQSeries Message”. As shown in Figure 360, select the MQSeries Inbound extension.
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Figure 360. Extension action



Select the properties of the MQSeries Inbound extension and set as shown in Figure 361. Set the general properties to PostUnparsed, that is put a message to the queue as a string of text.



Figure 361. MQSeries inbound - general
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Select the Inputs tab (Figure 362)and select the MessageOptions variable to represent the MQOptions business object. Select the Message variant to represent the InputVar variant.



Figure 362. MQseries inbound - inputs



Select the Outputs tab (Figure 363) and set the ReturnCodes variable to represent the StatusBO business object.
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Figure 363. MQSeries inbound - outputs



Select the Execution tab (Figure 364) and set the timeout interval to 5 minutes and select the TimeOut variant to contain the time out flag. Click OK.



Figure 364. MQSeries inbound - execution
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Verify the private process and save it. Return to the public process editor. Right-click the second Down Under Insurance Company process and select Activate Private Process. This concludes the private process definition.



9.5.3 Install the process for testing After the private processes that drive the actions on the public process have been defined, all partners should install the public process for testing. On the Down Under Insurance Company PAM Client, go to the process manager. Select the Rental Car public process, right-click it and select Process Manager. Select Install for Testing and select Apply. This will send the request to install for testing to the process owner which is Outback Car Rentals. Once the request for testing has been received from one participant, the owner will install for testing.



9.5.4 Setup PAM event triggering There are three ways that a process may be started. You can start it manually from the PAM Client window, which we will do for testing. You may schedule it to start at a specific time. Or, you may set it to be triggered by an event. As mentioned earlier, the initiation of the public process itself is to be triggered using PAM event triggering (see Figure 365), where the PAM adapter server polls for events that have been defined. In our case this will be the arrival of a message on a queue that is being polled by PAM. You will either need to modify the adapter instance or create one that is enabled to poll for events periodically. We will create an adapter instance that will be used specifically for polling a particular queue for this application.
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Figure 365. PAM event triggering



Go to the PAM Adapter Manager. Select Programs --> IBM WebSphere BtoB Integrator --> Partner Agreement Manager --> Adapter Manager (Down Under Insurance Company). Right-click the MQSeries Inbound adapter instance and select Duplicate. You will see Figure 366.



Figure 366. Event triggering



Name this duplicate adapter ”MQSeries - Event Triggering”.
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Select the Events tab (shown in Figure 367) and click the Enable polling for events radio button. Change the polling interval to 2 seconds. The lowest value for polling interval is 1 second.



Figure 367. Poll for events



Select the Properties tab, shown in Figure 368. Edit the DefaultQueue property to PAM.OUTBACK.RENTALS.OUTBOUND and select OK.



Figure 368. Queue to be polled
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Right-click this new adapter instance and select Start. You may leave the Adapter Manager. Return to the PAM Client to register the public process for event triggering.



Figure 369. Event processing



In the PAM Client (Figure 369) select the folder Processes --> Events. Select the MQSeries Event Triggering type. This event type was created when we created the adapter instance that contains a checkForEvents method. Each event has a list of processes that are “registered” with it, that is processes to start when an event is triggered. We will register the RentalCar process. Right-click this event and select Open. You will see the window in Figure 370.
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Figure 370. Event process registration



Select the Register button. You will see the window shown in Figure 371.



Figure 371. Register process



Select the Down Under Insurance Company - RentalCar public process for registration.
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Figure 372. Select expiration



Select the Expiration tab (Figure 372) and select No Expiration, that is, the action taken if a process triggered by the event has been suspended. It will wait indefinitely and start when the process is resumed. Select the General tab and click Select Variable. You will see Figure 373. This is the variable that will receive the event data when the process is triggered, in our case the message. Select InputMessage.



Figure 373. Select a variable
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Before you start the end-to-end PAM processing in a triggered mode, you should first check that the end-to-end processing is working correctly. Select the public process. Right-click the process name and select Start..



Figure 374. Start a process



This will manually start the public process. Check that the process name is correct and that you are starting the process in test mode. Select the Inputs tab (shown in Figure 375).



Figure 375. Process input



You do not currently have access to the contents of any messages on queues, so for the purposes of testing you can set the input as if it were
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received from the triggered event. For a sample message text, refer to the text file rentalrequest.txt. The file contains the contents of a correctly formatted test message. Copy and paste the contents of this file into the value field and select Set. Select OK to start the process. To see the status of your process in a sending state, if you are quick, select the folder Auditor --> Process Logs --> mmm YYYY --> date. This view, shown in Figure 376, will show the current status of the process.



Figure 376. Process audit - sending



There is currently nothing at the other end (Outback Car Rentals) running to emulate the processing of the back-end systems.
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Figure 377. Error log



Now start the process again and check the audit log for a successful end-to-end process (Figure 377). As there were many println procedures added to the scripts for processing, you will be able to see the contents and flow of the messages in the Process Server (see Figure 378).
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Figure 378. Process Server log



The log can be found at / Pam / Partners//logs/ProcessServer.log. You have successfully connected the companies and are ready to run the end-to-end application.
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Chapter 10. Stepping through the complete application In this chapter we bring all the pieces together again. We start by recalling the overall picture of the application and then run the application. At each step we explain what happens behind the scenes and what the information streams are.



10.1 Overview of the application It all starts when a customer calls the insurance company to report a car accident. The Call Centre operator introduces the customer number into the system and verifies the customer details. Then, the customer provides some details about the car accident. Based on his policy and his record, the customer can get the service of a rental car to continue his trip.
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Figure 379. Overview of the application



If the customer record requires so, approval may be required before the operator can offer the customer the extra service of a rental car. The operator collects the necessary information and sends it to the rental car company to obtain a confirmation number.
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Figure 380. Message flow of the application



Figure 380 shows the flow of messages in the enterprise. The left side of the diagram shows the MQSeries Workflow view, with the activities. The right side shows the message broker function of MQSeries Integrator and its interaction with the database. All parts are linked by using MQSeries clustering. Figure 381 shows the three different steps involved. Each step will be explained in the next sections.
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Figure 381. The three different steps of the application



10.2 Step 1: customer identification and verification The application starts by creating a new process instance in the MQSeries Workflow Client. The first step is illustrated in Figure 382.



Chapter 10. Stepping through the complete application
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Figure 382. Detailed view of the first step



When creating a new process instance, you can fill in the input container of this first activity, shown in Figure 383. When clicking OK, the GetCustomerDetails program is invoked as part of this activity. This program puts a message on a queue with the request to obtain the details for this customer. The MQSeries Integrator broker receives this message and sends it to the correct message flow. That flow contains the necessary database look-ups to collect the details of the customer out of the database. The broker builds a reply message and sends it to the waiting program.
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Figure 383. Filling in the Input data structure



When the getcustomerdetails program receives the reply, it prompts the end user to verify the database contents with the customer on the phone. The end user gets this information in a message box, as shown in Figure 384.



Figure 384. Customer verification message box



When the end user clicks the Yes button, the workflow goes to the second step. If the information is not correct, the process instance is terminated.



10.3 Step 2: Collect car incident details The second step (illustrated in Figure 385) involves the collection of the necessary details about the car incident. The Call Centre operator is provided with an interface to introduce the details in the system.
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Figure 385. Detailed view of step 2



This program, getincidentdetails, is shown in Figure 386.
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Figure 386. User interface of program getincidentdetails



When all information is provided, the program builds an MQSeries message and sends it to the broker. The broker sends the message through the correct message flow that contains database operations to create a claim record. The message flow also contains a node to verify the history record of the customer. Based on the information about this customer, the broker builds a reply message with the claim details and with a flag that represents the approval requirement.



Figure 387. Claim details, with approval requirement flag set to on.



When the getincidentdetails program receives the reply message from the broker and approval is required, a notification is sent to the Claims Manager to approve or disapprove the extra services for this customer. The approval request is shown in Figure 388.
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Figure 388. Approval notification



If the Claims Manager approves it, the Call Centre operator is taken to the next step.



10.4 Step 3: Fulfillment of extra services In this step (illustrated in Figure 389), the customer is offered the opportunity to get a rental car, overnight accommodation and towing to the nearest garage.
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Figure 389. Detailed view of step 3



The program builds a request message and sends it to the broker. The broker stores the information to track the requests for services by external companies. For each individual request of extra service, the broker builds a message that is delivered at the Partner Agreement Manager to contact the external companies. Figure 390 shows the interface of this program for the Call Centre operator.
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Figure 390. Interface for the request of extra services



The current application has only one external configuration. The application could easily be extended by sending e-mail to the towing company and by contacting a hotel. The application has only a Partner Agreement Manager link to the insurance company. When the request is sent to the rental company, the user is informed to wait for a reply.



Figure 391. Waiting for a confirmation from the rental company



At the rental company, the Partner Agreement Manager receives the message and puts it onto a triggered queue. The started application records the name of the driver and the location where the rental car should be delivered. Below is an extract of logging by back-end application at the rental company. ===> Customer Call Centre - Start of Outback Car Rentals Customer Call Centre - End of Outback Car Rentals 
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